
UC Davis
UC Davis Electronic Theses and Dissertations

Title
SynDIG4 is an auxiliary protein which regulates trafficking, gating, and synaptic plasticity of 
AMPA-type receptors

Permalink
https://escholarship.org/uc/item/42s8n029

Author
Plambeck, Kristopher Ernest

Publication Date
2022
 
Peer reviewed|Thesis/dissertation

eScholarship.org Powered by the California Digital Library
University of California

https://escholarship.org/uc/item/42s8n029
https://escholarship.org
http://www.cdlib.org/


 

 
i 

Elva D. Díaz, Chair 

Johannes W. Hell 

Karen Zito 

John Gray 

SynDIG4 is an auxiliary protein which regulates trafficking, gating, and 

synaptic plasticity of AMPA-type receptors 

By 
 

KRISTOPHER ERNEST PLAMBECK 
 

DISSERTATION 
 

Submitted in partial satisfaction of the requirements for the degree of 
 

DOCTOR OF PHILOSOPHY 
 

in 
 

Biochemistry, Molecular, Cellular, and Developmental Biology 
 

in the 
 

OFFICE OF GRADUATE STUDIES 
 

of the 
 

UNIVERSITY OF CALIFORNIA 
 

DAVIS 
 

Approved: 
 

 

  

 

 
 
 
 

 

 
 

Committee in Charge 

2022 



ii 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Copyright by 
Kristopher Ernest Plambeck 

2022 
 

 

 

 

 

 

 

 

 

 



 

iii 
 

 

Abstract 

 

Trafficking, localization, and biophysical properties of AMPA-type glutamate receptors 

(AMPARs) at synapses are predominant mechanisms for regulating synaptic strength underlying 

learning and memory. AMPARs are highly regulated by a number of auxiliary proteins such as 

TARPs, cornichons, and CKAMPs, as well as the members of the SynDIG/Prrt family, which will 

be the focus of this study. Previous studies of the transmembrane protein Synapse Differentiation 

Induced Gene 1 (SD1; SD1) as an AMPAR interacting protein that regulates excitatory synaptic 

strength and AMPAR number both in vitro and in vivo. The SynDIG family is defined by a family 

of four genes, SD1-4, which are expressed in distinct locations within the brain. SynDIG4 

(SD4/Prrt1) is primarily expressed within the hippocampus, the main site of memory formation in 

both mice and humans. SD4 was identified in several independent proteomic screens in complex 

with AMPARs, suggesting it may also function as an AMPAR auxiliary factor. We previously 

observed that long-term potentiation (LTP) is abolished by single tetanus stimulation of 

hippocampal slices from SD4 knockout (KO) mice.  In this study we demonstrate that only specific 

protein domains are necessary for clustering of AMPARs and SD4.  Furthermore, we observed that 

some SD4 co-localizes with extra-synaptic GluA1-containing AMPARs in primary neurons, while 

loss of SD4 results in reduced extra-synaptic AMPARs, implying a role of SD4 outside the 

synapse. We hypothesize that SD4 regulates AMPARs through maintenance of an extra-synaptic 

pool of GluA1-containing AMPARs required for trafficking and LTP.  
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Chapter 1: 

Introduction 

This chapter serves as a review of the function of the hippocampus regarding hippocampal 

dependent learning and memory formation. These studies focus on the interaction of α-amino-3-

hydroxy-5-methyl-4-isoxazolepropionic acid receptors (AMPARs) and previously characterized 

AMPAR interacting and auxiliary proteins. Furthermore, this chapter describes the importance of 

the role of AMPARs and AMPAR auxiliary proteins in activity dependent regulation, trafficking, 

and function during long term potentiation (LTP). 
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Introduction Outline 

I. The Hippocampus and Hippocampal Dependent Learning and Memory 

II. Ionotropic Glutamate Receptors 

a. N-methyl-D-aspartate (NMDA) receptors 

b. Kainate receptors 

c. α-amino-3-hydroxy-5-methyl-4-isoxazolepropionic acid (AMPA) receptors 

III. AMPAR interacting proteins 

a. Post-synaptic density protein 95kD (PSD-95) 

b. Neuronal activity-regulated pentraxin receptor (NARP; NP2) 

c. Leucine-rich repeat transmembrane protein (LRRTM) 

d. Glutamate receptor-interacting protein (GRIP) and Protein interacting with C-

kinase (PICK) 

e. Calcium/calmodulin dependent kinase II (CaMKII) 

IV. AMPAR auxiliary proteins 

a. Transmembrane AMPAR regulatory proteins (TARPs) 

b. Cornichons (CNIHs) 

c. Cysteine-knot AMPAR modulating proteins (CKAMPs) 

d. Synapse Differentiation Induced Gene (SynDIGs) 

V. Synaptic Plasticity 

a. Long Term Depression (LTD) 

b. Long Term Potentiation (LTP) 
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I. The Hippocampus and Hippocampal Dependent Learning and Memory 

Neuronal communication is carried out through electrochemical signals transmitted through 

projections from the cell body, called the axon terminals1.  These axon terminals form connections, 

or synapses, with the dendrites of other neurons to transfer information. The ability of mature 

neurons to form synapses remains the traditional method by which neurons are able to 

communicate within the brain1.  Specifically, the hippocampus, one of the brain regions identified 

as a prominent regulator of cognitive functions, has been widely implicated as the main site of 

learning and memory in both mice and humans2,3.  Importantly, the ability of the hippocampus to 

change over time has been regarded as a key characteristic underlying cognitive function, 

including memory formation4,5. 

Within the hippocampus lies the sub-granular zone of the dentate gyrus (DG), a site of 

active neural stem cell activity2-4.  Neural stem cells within the SGZ can differentiate and migrate 

outwards to the granule cell layer (GCL) of the DG where they are able to integrate into the tri-

synaptic circuit4,5. This neural circuit within the hippocampus consists of the DG, CA3, and CA1 

regions and is critical for cognitive functions5,6.   

The hippocampus remains the main site of interest underlying cognitive functions, 

including learning and memory in both mice and humans2,4.   Here,  they are able to integrate into 

the tri-synaptic circuit where new memories are formed and consolidated by strengthening a new 

neoural circuit4,5. This neural circuit within the hippocampus consists of the DG, CA3, and CA1 

regions and is critical for cognitive functions5,6.  The strengthening of hippocampal 

connections/circuits is thought to underlie learning and memory formation. Specifically, we are 
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studying excitatory synapses. At excitatory synapses, glutamate receptors are activated by the 

release of glutamate from synaptic vesicles of axon terminals in response to stimuli, resulting in 

activation of downstream calcium dependent processes. 

The ability of neurons to either strengthen or weaken due to patterns of stimulation results 

in synaptic plasticity. This occurs through regulation of synaptic plasticity at pos-synaptic 

dendritic spines, with each spine representing a possible site for synapse formation.  By identifying 

the mechanisms that regulate synaptic plasticity between neuronal spines and excitatory synapses, 

we may further understand the molecular basis of hippocampal dependent learning and memory. 

 

II. Ionotropic Glutamate Receptors 

Glutamate receptors predominantly regulate the synaptic communication of excitatory 

neurons in the brain35,36.  During synaptic transmission, pre-synaptic axon terminals responsible 

for export of signaling molecules pair with post-synaptic dendritic spines7-11. The pre-synaptic 

bouton contains hundreds of synaptic vesicles (SVs), which dock at the plasma membrane prior to 

synaptic activity7,11,12. These SVs then fuse with the membrane, allowing the export of cell 

signaling molecules, such as glutamate, across the synapse. Dendritic spines are densely populated 

with proteins that include glutamate receptors and ion channels which allow for the binding of 

molecules during synaptic transmission7,8,10,11,13-15. Signals received from pre-synaptic neurons 

trigger signaling cascades which dictate neuronal activity. There are three types of glutamate 

receptors located at the synaptic site: N-methyl-D-aspartate (NMDA), AMPA, and kainate 
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receptors7-9,13,16-18.  Previous studies have shown that NMDA receptors are first recruited to the 

dendritic surface7,9,11,13.  The recruitment of AMPA and kainate receptors stabilize the synapse and 

represent a mature synaptic structure11,18.  Together these glutamate receptors represent the most 

common type of receptor in the central nervous system (CNS), and are responsible for fast synaptic 

transmission, and have been found to play a crucial role in synaptic plasticity11,18-22. 

During synapse maturation, previous studies have shown that NMDA receptors are first 

recruited to the dendritic surface7,9,11,13. The recruitment of AMPA and kainate receptors stabilize 

the synapse and represent a mature synaptic structure11,18.  AMPAR trafficking is highly 

dynamic21,23. The regulation of AMPARs is a predominant mechanism for the regulation of 

excitatory transmission and have been shown to rapidly traffic between membrane compartments 

and the plasma membrane19,21,23. Receptors move laterally through the extra-synaptic plasma 

membrane and can enter and exit synapses in an activity dependent manner21,23. This is a highly 

regulated process, but mechanisms are not fully understood. An increase in synaptic AMPARs 

results in increased synaptic strength. Furthermore, impairment in AMPA receptor trafficking has 

been linked to several neurological disorders, such as Alzheimer’s disease24,25.  

            The activation of glutamate receptors occurs immediately after the release of glutamate 

from synaptic vesicles across the synapse14,16,26. Specifically, glutamate binds to glutamate 

receptors located at the post-synaptic density (PSD), the active site during synaptic transmission 

located on the tips of dendritic spines directly across from the axon terminal26. This results in an 

influx of calcium (Ca+2) into the dendritic spine26,27.  Additionally, it has been shown that NMDA 

receptors are the largest source of this Ca+2 influx27. Studies had previously shown that this Ca+2 



6 
 

influx triggers a diverse array of downstream signaling cascades responsible for multiple cellular 

processes28.  Researchers noticed that there seemed to be a direct correlation to an increase in actin 

polymerization and recruitment to the PSD28-30. Furthermore, it was observed that by directly 

inhibiting NMDA receptor activation, there was a decrease in actin recruitment and an overall 

decrease in spine dynamics28,30.  Therefore, it was concluded that the activation of NMDA 

receptors directly regulates the upregulation of actin polymerization responsible for spine 

morphogenesis. 

 

III. AMPAR interacting proteins 

As mentioned previously, AMPARs are highly dynamic and can rapidly move in and out of the 

plasma membrane in an activity dependent manner19,21,23.  From their assembly onwards a “dimer 

of dimers” of four highly homologous subunits GluA1-4 AMPARs don’t function or travel alone, 

but are surrounded by a wide-array of proteins which guide their subcellular localization31. The 

role of AMPAR interacting proteins has become of significant interest since it be came clear that 

these auxiliary proteins play a significant role in regulating AMPAR trafficking and function32,33. 

The gating properties of AMPARs (i.e. activation time, inactivation time, latency) are another way 

to measure surface AMPAR activity.  Researchers noticed that surface AMPAR number and 

AMPAR activity was significantly different in heterologous cells when compared to the activity 

of AMPARs in wildtype (WT) neurons.  Therefore, it was concluded that there must be additional 

AMPAR interacting proteins present that must have an effect on both the trafficking and gating 

properties of AMPARs33. 
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 AMPARs are widely distributed throughout the brain and consist of four glutamate 

receptor subunits GluA1-433.  Within the hippocampus, the AMPAR subunits GluA1 and GluA2 

are highly expressed and have shown to be necessary for LTP34,35.  Furthermore, it was observed 

that when either AMPAR subunit GluA1 or GluA2 are co-expressed in the presence of specific 

AMPAR interacting proteins, there is a significant difference in the gating properties compared to 

GluA1 and GluA2 alone36,37.  These AMPAR interacting proteins will further be classified as 

AMPAR auxiliary proteins.  Additionally, there was a significant increase in the number of surface 

AMPARs when GluA1 or GluA2 were co-expressed with AMPAR auxiliary proteins when 

compared to GluA1 or GluA2 alone38,39.  AMPAR auxiliary proteins have been shown to increase 

surface expression of AMPARs and alter gating proprerties38,40. Interestingly, STG/Tarp-γto 

induce the clustering of GluA1 and GluA2-containing AMPARs when co-expressed in 

heterologous cell, although only in the presence of PSD-9533,39.  This result was further duplicated 

in dissociated hippocampal cells where both surface GluA1 and surface GluA2 increased, while 

there was a significant increase in localization of GluA1 and GluA2 with its potential AMPAR 

auxiliary binding protein, which is further exacerbated by induction of LTP.  This provides 

evidence that AMPAR auxiliary factors bind GluA1- or GluA2-containing AMPAR, alter their 

surface trafficking and gating properties, and affect localization of AMPAR and AMPAR auxiliary 

proteins in an activity dependent manner. 

 Like many proteins, AMPARs contain sites for post-translational modifications, including 

phosphorylation and palmitoylation, which also mediate the trafficking and localization of these 

GluA1 and GluA2-containing AMPARs (See AMPAR topology map below). Although GluA1 
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and GluA2 are similar in structure, they contain unique phosphorylation and palmitoylation sites.  

Likewise, GluA1 and GluA2 contain unique binding sites for important AMPAR regulating 

interacting proteins.  Just a few of these proteins of interest include PSD-95, NARP, LRRTM, 

GRIP, PICK, CaMKII, PKA, and PKC33,41. 

 

Topology of AMPARs and auxiliary binding sites. 

 

a. Post-synaptic density protein 95 kD (PSD-95) 

PSD-95 is a scaffolding protein which binds to actin filaments within dendritic spines and anchors 

synaptic proteins to the PSD13,39,42,43.  Proteins that bind to PSD-95 include a PDZ binding motif 

which has been shown to be highly conserved across multiple PSD binding proteins42,44.  
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NMDARs contain a PDZ binding motif which allows receptors to bind to PSD-95 at the PSD42,44.  

This results in NMDARs becoming a mostly fixed component of the PSD39,44.  Conversely, 

AMPARs do not contain a PDZ binding motif and are unable to bind to PSD-95 directly42,44.  

AMPARs must bind to the PSD through an intermediate protein interaction whereby AMPARs 

are bound with an AMPAR interacting or auxiliary protein that allows them to anchor to the PSD44.  

Therefore, AMPARs are able to rapidly enter and exit the plasma membrane in an activity 

dependent manner and bind to the PSD, increasing the overall number of surface AMPARs42,44. 

 

b. Neuronal activity-regulated pentraxin receptor (Narp; NP2) 

Narp, also known as NP2, has been observed to mediate AMPAR clustering at synaptic 

contacts13,45-48.  NP1 and NP2 are secretary proteins which bind to the extra-cellular integral 

membrane protein Neuronal Pentraxin Receptor (NPR) where it becomes bound, potentially 

forming a transsynaptic complex13,47,49.  The formation of this complex results in strengthening 

and maturation of the synaptic contact13,49.  It had previously shown that the N-terminal domain 

(NTD) of GluA4 is necessary for interaction and synaptic recruitment of GluA4-containing 

AMPARs13,50.  Another study used a dominant negative form of Narp mutant protein to reduce 

NP1 and NP2 activity50.  This resulted in an overall decrease in synaptic clustering of AMPARs 

and a reduction in the number of excitatory synapses in transfected neurons50.  Furthermore, NP1/2 

knockout neurons result in a reduction of AMPAR mediated synaptic transmission and an increase 

of silent synapses, suggesting NP1/2 are critical for synaptic recruitment of AMPARs in an activity 

dependent manner13,51. 
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c. Leucine-rich repeat transmembrane protein (LRRTM) 

LRRTMs were observed to effect the differentiation of glutamatergic synapses at both pre-synaptic 

and post-synaptic sites52,53.  There are four LRRTM genes in mammals, with all four being highly 

expressed in the brain52,53.  LRRTM1/2 have been shown to induce primarily pre-synaptic 

glutamatergic differentiation52,53.  Furthermore, it was observed that LRRTM2 clusters with 

multiple types of AMPARs, while LRRTM1 primarily affects synaptic organization, resulting in 

the formation of a mature synaptic complex, while mutations in either LRRTM1 or LRRTM2 

affects formation of a mature trans-synaptic organizing complex resulting in decreased 

differentiation of glutamatergic synapses52,54.  Additionally, shRNA-mediated knockdown (KD) 

of LRRTM1/2 eliminates LTP in hippocampal neurons55.  Replacement of LRRTM2-KD neurons 

with the LRRTM2 extra-cellular domain rescues LTP, indicating that this domain is sufficient for 

expression of LTP54,55.  Furthermore, the number of surface AMPARs is significantly reduced in 

LRRTM2-KD neurons, providing evidence that LRRTM2 is required for both LTP and AMPAR 

trafficking during synaptic development54-56. 

 

d. Glutamate receptor-interacting protein (GRIP) and Protein interacting with C-kinase 

(PICK) 

The dynamic regulation of AMPAR trafficking to, from, and within the synaptic membrane is a 

primary component of LTP and synaptic strengthening32. In addition to their spatio-temporal 

localization, the overall strength and stability of the interaction between the auxiliary proteins and 

AMPARs is highly dynamic57. Some interacting proteins were identified in complex with 
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AMPARs through several repeated proteomics studies and have been classified as parts of a native 

AMPAR complex. The interacting protein (GRIP1) and protein interacting with C-kinase 

(PICK1), were identified in several proteomic studies58-60.  

AMPAR subunits GluA2 and GluA3 share a common PDZ binding sequence consisting of 

four amino acid residues, -SVKI at the C-terminus, allowing interactions with PDZ domain-

containing proteins, such as PSD-9561. The role of GRIP1 is less understood at synaptic 

localizations, however, previous studies have shown that GRIP1 is necessary for synaptic insertion 

of AMPARS62-64, while other auxiliary proteins have been observed to actively remove synaptic 

AMPARs41,65,66.  GRIP1 and PICK1 bind to GluA2 through phosphorylation by protein kinase C 

(PKC), resulting in a decreased affinity to GluA2, but no effect on PICK1 activity.  This could 

further indicate a mechanism by which the release of GluA2 from GRIP1, opening up potential 

binding sites for PICK1, which facilitate the insertion and trafficking of synaptic GluA265. 

Previous studies have proposed a complementary role for GRIP1 and PICK1 in regulating the 

insertion and trafficking of surface AMPARs62,64,67. According to other studies, PICK1 

additionally regulates AMPAR recycling as PICK1 knockout neurons displayed an increased 

recycling rate of surface AMPARs to the surface without effecting internalization67-70.  LTP is 

prevented by PICK1 knockdown and occluded by PICK1 overexpression71. However, another 

study found no defective LTP in PICK1 knockout slices70. These differing results could be 

attributed to the experimenter, neuronal isolation, and overall health of the neuronal cultures and 

slices.  Different results could also be due to variable technique, where an acute knockdown or 
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chronic knockout can present conflicting data.  Furthermore, PICK1 induces clustering of AMPA 

receptors in heterologous cell culture expression systems. 

Lastly, GRIP1/2 double KO mice show increased surface GluA2-containing AMPARs, with 

gain-of-function mutations using transgenic mice display enhanced surface localization, 

trafficking, and faster recycling of AMPARs72,73.  

 

e. Calcium/calmodulin dependent kinase II (CaMKII) 

NMDAR dependent LTP requires the activation of NMDAR by the activity dependent release of 

pre-synaptic glutamate74,75.  This results in the influx of Ca+2 through post-synaptic NMDARs75.  

Ca+2-dependent activation and autophosphorylation of Ca+2/calmodulin-dependent protein kinase 

II (CaMKII) further results in an increase in surface AMPAR at the plasma membrane74,75.  LTP 

induction in primary hippocampal neurons found an increase in autophosphorylation and 

activation of CaMKII, which was blocked by the CaMKII inhibitor KN-6274-77.  Additionally, the 

AMPAR subunit GluA1 is preferentially phosphorylated by CaMKII resulting in a significant 

increase in surface GluA1 after LTP induction74,77.  Inhibition of CaMKII activity prevents the 

NMDAR-dependent trafficking of GluA1 to the plasma membrane74,76.  Therefore, it was 

concluded that activation of CaMKII through NMDAR-dependent LTP induction is crucial for 

expression of LTP and trafficking of GluA1-containing AMPARs74,75. 
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IV. AMPAR auxiliary proteins 

Modulation of AMPARs is a predominant mechanism for the regulation of excitatory 

transmission19,20,22,78,79. Previous studies have attempted to understand the mechanism by which 

AMPARs are trafficked to the synapse and have identified a diverse group of AMPAR interacting 

proteins8,39,80-82. For example, the AMPAR auxiliary protein Stargazin, a member of the 

transmembrane AMPAR regulating protein (TARP) family, has been observed to directly 

modulate trafficking of AMPARs to the cell surface39,80-83. Additional AMPAR auxiliary proteins 

such as the Cornichons (CNIHs), cysteine-knot AMPAR modulating proteins (CKAMPs), and 

synapse differentiation induced genes (SynDIGs) have also been shown to affect AMPAR 

trafficking and functional properties of AMPARs, including sensitivity to glutamate39,46,59, 

resulting in increased LTP and synaptic strength.  Therefore, AMPAR localization and function is 

regulated by a wide array of mechanisms. 

 

Topology of AMPAR auxiliary proteins36. 
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a.   Transmembrane AMPAR regulatory proteins (TARPs) 

TARPs are a family of eight proteins that consist of an intracellular N-terminus, four 

transmembrane domains, two extracellular loops, and an intracellular C-terminus. Stargazin (STG; 

TARP-γ2) has been found to be highly expressed in the cerebellum and has been identified to 

regulate AMPARs through two distinct domains83.  STG regulates AMPAR gating kinetics 

through the extracellular loop domains, while the C-terminus is necessary for the surface 

trafficking of AMPARs83.  Furthermore, it has been observed that TARP- γ8 specifically 

modulates the gating kinetics of AMPARs through extracellular loop 2 and the transmembrane 

domains 3 and 4 (Ben-Yaacov, Stern-Bach, 2017). While STG is highly expressed in the 

cerebellum, TARP- γ8 has been identified to be expressed primarily in excitatory hippocampal 

neurons, making them a candidate regulator of hippocampal AMPARs84. Previous studies have 

shown that TARP- γ8 increases basal levels of surface AMPARs, both synaptic and extra-synaptic, 

and enhances hippocampal dependent LTP, while a loss of TARP- γ8 negatively regulates these 

properties57. Therefore, TARPs play a critical role in the regulation of AMPARs. 

 

b.   Cornichons (CNIHs) 

CNIHs were initially identified in a proteomics study used to identify additional AMPAR 

interacting proteins, with hippocampal AMPARs found to associate mostly with CNIH-2 and 

CNIH-332,58. CNIH-2/3 bind AMPARs, promote surface trafficking, and slow AMPAR 

deactivation kinetics, while a loss of CNIH-2/3 results in the reduction of AMPAR synaptic 

transmission due to the decrease of surface GluA1-containing AMPARs85,86. Additionally, it was 
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observed that CNIHs negatively regulate the binding of TARP- γ8 to AMPARs, indicating that 

TARPs and CNIHs may work in tandem to create a specific AMPAR complex and affect the 

number and strength of surface AMPARs85,86. 

 

c.   Cysteine-knot AMPAR modulating proteins (CKAMPs) 

An additional proteomics study identified a family of proteins known as CKAMPs, specifically 

CKAMP44, in complex with AMPARs87. This protein family has been further characterized as a 

novel auxiliary subunit family distinct from other AMPAR interacting proteins88.  While TARPs 

and CNIHs are primarily expressed within the CA1 region of the hippocampus, CKAMP44 was 

found to be primarily expressed within the dentate gyrus87.  Furthermore, even though the 

CKAMPS, like AMPARs, are very similar in structure, their ability to modulate gating properties 

of AMPARs is very diverse.  Therefore, CKAMP44 and its family members precisely control 

AMPAR function88,89. 

 

d.   Synapse Differentiation Induced Genes (SynDIGs) 

The Synapse Differentiation Induced Gene (SynDIG) family of transmembrane proteins have been 

implicated in the regulation of AMPARs. The type-II transmembrane protein SynDIG1 (SD1) was 

previously identified in a microarray-based approach and found to act as an AMPAR interacting 

protein responsible for synapse development and localization of AMPARs15,90. Specifically, SD1 

co-localizes with AMPARs in heterologous COS cells and directly modulates the number of 
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functional GluA1 and GluA2 containing AMPARs at excitatory synapses90. These data provide 

evidence for the SD1 regulation of development and function of AMPAR containing synapses.  

SD1 is a highly conserved transmembrane protein that is expressed throughout the brain 

with elevated levels localized to the hippocampus and cerebellum7,9-11,91. It has been observed that 

upon loss of SD1, the total AMPA receptor content at synapses is reduced by ~50% resulting in 

an overall decrease in synapse formation90. Conversely, overexpression of SD1 increases 

excitatory synapse development, as well as the number of AMPA receptors at synapses. 

Furthermore, SD1 has been shown to affect the distribution of the AMPAR subunits GluA1 and 

GluA2.  

Using heterologous cells, co-expression of SD1 with GluA2 showed a strong clustering 

phenotype between the two proteins, leading to the clustering of these AMPAR subunits in vitro11.  

Additionally, co-expression of GluA2 with a modified form of SD1 containing a C-terminus 

deletion with the membrane bound regions preserved lead to the inhibition of this clustering 

behavior. Therefore, it was successfully shown that the C-terminus domain of SD1 is necessary 

for interaction with the AMPA receptor GluA2 through its C-terminus domain. However, the 

GluA2 domain responsible for this interaction remains unknown. SD1 has two transmembrane 

domains with an intracellular N-terminus and extracellular C-terminus7,11.  GluA2 has four 

transmembrane domains with the opposite orientation, having an extracellular N-terminus and 

intracellular C-terminus18.  Due to the orientation of these two proteins, we postulated that either 

the C-tail or transmembrane domains of GluA2 were responsible for this interaction with the C-

terminus of SD1. However, the C-tail of GluA2 is in the opposite orientation to that of SD1. 
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Therefore, we hypothesized that the transmembrane domains of GluA2 were responsible for the 

interaction with SD1. 

SynDIG4 (SD4), also known as Proline-rich transmembrane protein 1 (PRRT1), was 

identified by three independent proteomic studies58,60,87 and demonstrates sequence similarity to 

SD190.  Therefore, SD4 has been identified as a candidate regulator of AMPARs at excitatory 

synapses. 

Using multiple electrophysiological recording prototocols, we observed that LTP is only 

affected after single-tetanus LTP induction, indicating the importance of SD4 for functional LTP 

under specific signal transduction. Acute hippocampal slices were prepared using both wildtype 

(WT) and SD4 knockout (KO) mice. An electrode was used to stimulate Schaffer collateral axons 

onto CA1 hippocampal neurons. In WT mice, recordings showed an increase in stable excitatory 

post-synaptic potentials (EPSPs) after stimulation, indicative of LTP induction. However, in SD4-

KO mice, there were deficits in LTP with no stable increase in EPSPs37.  Interestingly, LTP in 

SD1-KO neurons appears normal, indicating a specificity for SD4 in mediating LTP. 

Importantly, SD4 has been observed in complex with AMPARs, with an affinity for the 

AMPAR subunit GluA158. SD4 was subsequently identified as another potential regulator of 

AMPA receptor trafficking. However, little is known regarding the significance of this interaction. 

 

V. Synaptic Plasticity      

Synaptic plasticity and LTP was first characterized in a study whereby neurons were repeatedly 

stimulated within the perforant path of the DG in anesthetized rabbits92.  This study presented the 
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conclusion that there were two distinct mechanisms underlying LTP: increased efficiency of 

synaptic transmission at these synapses, and increased excitability in the GCL92.  The activity-

dependent modulation of synaptic AMPARs is understood to be a mechanism whereby 

information is stored in neural networks that give rise to higher order cognitive functions.  LTP 

has been widely accepted as the cellular mechanism underlying learning and memory92,93.  

Specifically, high frequency stimulation of a synapse results in an overall increase in the efficacy 

of synaptic transmission92,93.  Previous studies have established the importance of AMPARs in 

LTP, with AMPARs mediating fast excitatory post-synaptic currents94.  Initially it seemed that the 

necessity of AMPARs for LTP is subunit specific, with deficits in LTP only seen after a loss of 

the AMPAR subunit GluA194.  However, recent findings suggest that maintenance of an extra-

synaptic pool of AMPARs may be more important, independent of subunit specificity95. 

Pioneering studies using confocal and two-photon microscopy has allowed for the 

visualization of individual neurons and dendritic spines allowed for the manipulation and imaging 

of these changing neuronal processes96,97.  By locally releasing glutamate in hippocampal slices 

researchers can stimulate individual spines, allowing for either an increase or decrease in the 

overall size of synaptic spines, indicating a potentiated synapse97.  Furthermore, it has since been 

shown that treatments involving exercise and caloric restriction can generate pro-youthful factors 

and pro-aging factors, which can additionally modulate the synaptic density of neurons, ultimately 

leading to increased learning and memory formation as a mechanism of decreasing cognitive 

decline98-101.  These studies have further linked structural and functional plasticity in excitatory 

synapses34. 
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Chapter 2 

 

Bi-directional clustering of SynDIG4/PRRT1 and AMPA receptor subunits GluA1 and 

GluA2 in heterologous cells 

 

Preface: 

In this chapter, I performed most biochemistry and immunochemistry experiments, as well as data 

analysis. Chun-Wei (Jay) He performed additional immunochemistry replicate experiments of 

Figure 7. Both Chun-Wei (Jay) He and Hector H. Navarro were instrumental in blinding confocal 

images and performing data analysis. 

 This chapter was published in the journal “Frontiers in Molecular Neuroscience” on 

April 8, 2022.  For the purpose of this dissertation Figure 8 from Plambeck et al. 2022. has been 

been replaced with a working model, and moved to Chapter 3, Figure 2 to separate heterologous 

cells and neuronal data. 
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ABSTRACT 

Regulation of AMPA-type glutamate receptors (AMPARs) at synapses is a predominant 

mechanism for regulating synaptic strength. We identified the transmembrane protein Synapse 

Differentiation Induced Gene 1 (SD1; SD1) as an AMPAR interacting protein that regulates 

excitatory synaptic strength and AMPAR number both in vitro and in vivo. The related protein 

SynDIG4 (SD4; also known as PRRT1) was identified in several independent proteomic screens 

in complex with AMPARs, suggesting it may function as an AMPAR auxiliary factor. Here, we 

show that co-expression of SD4 with GluA1 or GluA2 homomeric AMPARs in COS cells leads to 

a 50% or 33% increase in the mean area of AMPAR puncta, respectively. This effect is accentuated 

when AMPAR puncta are stratified for co-localization with SD4, resulting in a 100% and 65% 

increase in GluA1 and GluA2 puncta, respectively. Chimeric proteins expressing only the 

membrane bound domain of SD4 co-expressed with full-length GluA1 or GluA2 recapitulated the 

effects of wild-type SD4. Additionally, the mean puncta area of GluA1 or GluA2 chimeras 

expressing the membrane and C-terminal domains increased significantly when co-localized with 

wild-type SD4. Similarly, co-expression of GluA1 or GluA2 with SD4 results in a significant 

increase in the mean area of SD4 puncta co-localized with GluA1 or GluA2, respectively. These 

data indicate bi-clustering of SD4 and AMPAR subunits both in COS cells, suggesting a 

mechanism for SD4 regulation of AMPARs that may play a role in regulation of synaptic strength. 
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INTRODUCTION 

Neurons form precise connections known as synapses that are necessary for cell-cell 

communication. During excitatory synapse development, pre-synaptic axon terminals responsible 

for export of signaling molecules pair with post-synaptic dendritic spines that contain glutamate 

receptors, scaffolding molecules and cytoskeletal elements1.  At excitatory synapses, there are two 

types of glutamate receptors which are recruited to the synaptic site via different mechanisms2: N-

methyl-D-aspartate receptors (NMDARs) and α-amino-3-hydroxy-5-methyl-4-isoxazolepropionic 

acid receptors (AMPARs).  NMDARs are first recruited to the dendritic surface during early 

maturation of excitatory synapses while the later recruitment of AMPARs stabilize the synapse 

and represent a mature synaptic structure3.  AMPARs are necessary for fast synaptic transmission, 

and changes in the number of synaptic AMPARs directly reflect changes in synaptic strength4.  

Previous studies have identified a diverse group of AMPAR interacting proteins necessary for 

modulation of AMPAR biophysical properties and trafficking to the synapse5-7. For example, the 

AMPAR auxiliary protein Stargazin, a member of the transmembrane AMPAR regulating protein 

(TARP) family TARP-γ2, has been observed to decrease the deactivation and desensitization rates 

of AMPARs, as well as traffic AMPARs to the cell surface8. Stargazin/TARP-γ2 influences 

AMPARs through interaction with two distinct protein domains9,10, of which the transmembrane 

(TM) domains TM3 and TM4 and extracellular loop 2 of Stargazin/TARP-γ2 have been found to 

be critically important11. Additional AMPAR auxiliary proteins such as the Cornichons (CNIHs)12 

and cysteine-knot AMPAR modulating proteins (CKAMPs)13 have also been shown to affect 

functional properties of AMPARs.  Therefore, AMPAR localization and channel properties are 

regulated by a wide array of distinct molecules. 
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The brain-specific type II transmembrane protein Synapse Differentiation Induced Gene 1 

(SD1; SD1) was previously identified as an AMPAR interacting protein which regulates excitatory 

synapse development14.  Specifically, SD1 clusters with AMPARs in heterologous cells and 

modulates the number of functional GluA1 and GluA2 containing AMPARs at excitatory 

synapses. Knockdown of SD1 results in a decrease in the number and strength of excitatory 

synapses. However, SD1 does not affect the biophysical properties of AMPARs, such as 

deactivation and desensitization to glutamate15, indicating SD1 is not a typical auxiliary factor. 

SynDIG4 (SD4), also known as Proline-rich transmembrane protein 1 (PRRT1), was 

identified by three independent proteomic studies13,16,17 and demonstrates sequence similarity to 

SD114. Surprisingly, SD4 is de-enriched at the post-synaptic density (PSD) and co-localizes with 

the AMPAR subunit GluA1 at extra-synaptic sites in primary neurons18, implying a role of SD4 

outside of the PSD. SD4 has been shown to modify AMPAR gating kinetics in a subunit-dependent 

manner19.  Specifically, SD4 slows deactivation of GluA1 homomers, as well as GluA1/A2 

heteromeric AMPARs. Additionally, SD4 slows desensitization of GluA1 homomers but not 

GluA1/A2 heteromers. Interestingly, these effects are potentiated when also expressed with 

TARP-γ819, indicating that SD4 may function in AMPAR complexes containing TARP-γ8.  In 

support of this conclusion, a recent cryo-electron microscopy (cryo-EM) study demonstrated that 

SD4 is associated with native AMPAR complexes that contain both TARP-γ8 and CNIH-220. 

The primary goal of this study is to further elucidate the role of SD4 in regulating GluA1- 

and GluA2-containing AMPARs using a structure-function approach. The link between AMPAR 

subunits and SD4 is necessary to establish a mechanism by which SD4 may affect the localization 
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and trafficking of AMPARs important for synaptic plasticity in the brain. We hypothesize that 

SD4 is necessary for establishing a reserve pool of AMPARs important for synaptic plasticity 

through its ability to cluster AMPARs at extra-synaptic sites. The present study identifies the 

regions sufficient for clustering of SD4 and the AMPAR subunits GluA1 and GluA2 in 

heterologous COS cells. As a result, colocalization of SD4 and AMPAR subunits indicates bi-

directional clustering of AMPAR subunits and SD4, respectively.  
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MATERIALS/METHODS 

 

Antibodies 

The following antibodies were used: rat IgG1 anti-GluA1 [Neuromab; Cat# 75-327; RRID: 

AB_2315840; Immunocytochemistry (ICC) 1:200; Immunoblotting (IB) 1:2000]; rat IgG1 anti-

GluA2 [Neuromab; Cat# 75-002; RRID: AB_10674575; ICC 1:200; IB 1:2000]; mouse IgG2a 

anti-SynDIG4 [NeuroMab; Cat# 73-409; RRID: AB_2491106; ICC 1:200; IB 1:2000]; mouse 

IgG2a anti-SD1 (NeuroMab; Cat# 75-251; RRID: AB_10999753; ICC 1:200); rabbit anti-IFITM3 

(ProteinTech; ICC 1:200; IB 1:2000); rat anti-hemagglutinin (HA) (Roche; ICC 1:50; IB 1:1000); 

Alexa 488-conjugated anti-mouse IgG2a (Molecular Probes; ICC 1:200) and Alexa 594-

conjugated anti-rat (Jackson ImmunoResearch; ICC 1:200); mouse anti-beta tubulin 

(MilliporeSigma; Clone: AA2; IB 1:5000); goat horseradish peroxidase (HRP) conjugated anti-rat 

(Invitrogen; IB 1:5,000); goat HRP-conjugated anti-mouse (Invitrogen; IB 1:10,000). 

 

Constructs 

Full length version of rat SD4 coding sequence was amplified by PCR from pHM6 expression 

vector and subcloned into pRK5 vector backbone provided by our collaborator Dr. Yael Stern-

Bach at the Hebrew University of Jerusalem. Full length version of mouse SD1 was expressed 

using a previously generated pHM6 construct14.  pCMV-HA-mIFITM3 was a gift from Howard 

Hang & Jacob Yount (Addgene plasmid #58389; http://n2t.net/addgene:58389; RRID: 

Addgene_58389). SD4/IFITM3 chimeras (Table 1) were generated by sequential PCR 

amplification using megaprimers. SD4/IFITM3 chimeras (Table 1) were generated by sequential 
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PCR amplification using megaprimers. Full length wildtype (WT) GluA1 was provided from the 

Stern-Bach lab and subcloned from the pGEM vector to the pRK5 expression vector. DNA vectors 

expressing full length GluA2 and GluK2, as well as the GluK2/A1 (Table 2, chimera #2-4) and 

GluK2/A2 (Table 3, chimera #1,2) chimeras, were additionally provided by the Stern-Bach lab. 

Additional GluK2/A1 (Table 2, chimeras #1,5,6) and GluK2/A2 (Table 3, chimera #3) constructs 

were generated by sequential PCR amplification using the megaprimer method. All constructs 

contain an in-frame HA tag at the N-terminus for detection. Tables 1-3 identify the amino acid 

(a.a.) sequences of the indicated protein expressed within each chimeric molecule. 

 

Table 1. SD4/IFITM3 chimeras. 

HA-IFITM3/SD4 IFITM3 SD4 

1.) HA-IF-NTD/SD4-M a.a. 1-59 a.a. 224-306 

2.) HA-SD4-NTD/IF-M a.a. 60-137 a.a. 1-223 

 

Table 2. GluK2/GluA1 chimeras. 

HA-K2/A1 GluK2 GluA1 

1.) M1-3,S2,M4,CT a.a. 1-561 a.a. 537-907 

2.) M1-3,M4,CT a.a. 1-561; a.a. 660-819 a.a. 537-631; a.a. 806-907 

3.) M1-3, CT a.a. 1-561; a.a. 660-840 a.a. 537-631; a.a. 827-907 

4.) M1-3 a.a. 1-561; a.a. 660-908 a.a. 537-631 
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5.) S2,M4,CT a.a. 1-659 a.a. 632-907 

6.) M4,CT a.a. 1-819 a.a. 806-907 

 

Table 3. GluK2/GluA2 chimeras. 

HA-K2/A2 GluK2 GluA2 

1.) M1-3,S2,M4,CT a.a. 1-561 a.a. 543-883 

2.) M1-3,S2,M4 a.a. 1-561; a.a. 841-908 a.a. 543-838 

3.) M4,CT a.a. 1-819 a.a. 810-883 

 

Cell culture 

The primate cell culture line COS-7 (ATCC CRL-1651) was used for all experiments. COS cells 

were grown in COS media containing DMEM (Life Technologies) supplemented with 10% Fetal 

Bovine Serum (Fisher Scientific) and 1% Penicillin/Streptomycin (Life Technologies). Cells were 

cultured at 37oC with 5% CO2. 

 

Immunoblotting 

COS cells were seeded in 6-well plates at a density of 300,000 cells per well in COS media. 

Transfection was performed with 2 µg of DNA using Lipofectamine 2000 (Invitrogen). Cells were 

lysed for protein extraction 24 hours after transfection using a standard lysis buffer (150 mM NaCl, 
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50 mM TRIS pH 7.4, 5 mM EDTA, 1% Triton x-100, 1 mM PMSF, and protease inhibitor 

cocktail). Cells were lifted using a cell scraper and then passed through a 22.5-gauge needle before 

transferring lysates to 1.5 mL microfuge tubes. Lysates were then transferred to a rotator at 4oC 

for 30 minutes. After 30 minutes, lysates were centrifuged at 12,000 rpm for 10 minutes at 4oC. 

Supernatant was removed and flash frozen in liquid nitrogen for long term storage. In preparation 

for immunoblotting, protein samples were thawed on ice. For all blots, 10 µg protein per sample 

was denatured at 95oC and loaded onto freshly poured 8% SDS-PAGE. Gels were run for 90 

minutes at 120V and transferred to nitrocellulose membrane for one hour at 100V. Membranes 

were blocked in 5% milk diluted in tris-buffered saline with tween-20 (TBST) for one hour. For 

testing expression of AMPAR chimeras, membranes were incubated with both rat anti-HA 

antibodies and mouse anti-tubulin antibodies at 4oC overnight. For testing expression of 

SD4/IFITM3 chimeras, membranes were incubated with anti-SD4, anti-IFITM3, and anti-tubulin 

antibodies at 4oC overnight. Membranes were washed with TBST and incubated in HRP 

conjugated goat anti-rat and HRP-conjugated goat anti-mouse secondary antibodies for one hour 

at room temperature. Luminata Crescendo reagent was added to membrane for direct detection of 

HRP signal (Azure Biosystems). 

 

Immunocytochemistry 

COS cells were plated in 6-well plates containing coverslips coated with poly-L-lysine (Sigma-

Aldrich). Cells were plated at a density of 300,000 cells per well and cultured for 24 hours prior 
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to transfection. All transient transfection experiments contained a total of 2 µg of DNA (1.75 µg 

receptor and 250 ng of either SD4 or pRK5 empty vector) using Lipofectamine 2000 (Invitrogen) 

and cells were cultured for an additional 24 hours. For live labeling, cells were first incubated at 

4oC for 10 minutes. Cells were washed once with cold PBS and incubated in rat anti-HA antibody 

diluted in COS media for 20 minutes at 4oC. After primary staining, cells were washed three times 

with cold PBS and incubated in donkey Alexa 594-conjugated anti-rat secondary antibody diluted 

in COS media for 20 minutes. Cells were washed three times with cold PBS and then with warm 

COS media. Plates were transferred back to 37oC incubator for 30 minutes. Cells were washed 

with PBS and fixed in 4% paraformaldehyde for 10 minutes. 

For staining of total SD1 or total SD4, coverslips were incubated in 0.1% Triton-X100 

diluted in PBS for 15 minutes. Cells were blocked with 5% milk in PBS for 30 minutes and 

incubated in primary antibody for 1.5 hours at room temperature. Coverslips were washed three 

times with PBS and incubated in donkey Alexa 488-conjugated anti-mouse IgG2a for one hour. 

Coverslips were washed three times with PBS and mounted on slides with Fluoromount G 

(Southern Biotech). 

 

Image Analysis 

For quantitative analyses, images were taken using either an Olympus FluoView 1000 or Zeiss 

LSM510 confocal microscope with a 63x/1.5 NA oil objective with identical settings for laser 
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power, photomultiplier gain, and digital offset. Pinhole (1 AU) and resolution (1024 x 1024 pixels) 

were constant for all images. 

Images were analyzed blinded to the experimental condition. Image files were imported 

into image analysis software (ImageJ) to determine average size of clusters for each condition. 

Selected cells were cropped from the original pictures and saved, blinded, and subjected to the 

analysis by an individual not involved in the cell selection and blinding process. The threshold for 

each independent experiment is determined by averaging the thresholds of at least 25% of images. 

The average threshold was then applied to all images for analysis. Only clusters within the range 

of 0.1 – 3.5 µm2 were measured. After data collection and the unblinding process, the puncta size 

of all signals was subjected to statistical analysis. For analysis of puncta size based on co-

localization with SD4 (stratification analysis), co-localization was defined as overlap of ≥1 pixel. 

The highlighted colocalized puncta in the image for the receptor with SD4 were then used to select 

unambiguous single puncta manually in the receptor mask image. XY coordinates were used to 

confirm the selected puncta in the receptor mask image that corresponded with the highlighted 

puncta in the receptor with SD4 image. For figure preparation, signals were adjusted for all panels 

within a figure by using equal linear adjustments of levels in Photoshop (Adobe Systems). 

 

Statistical analysis 

Data were collected from at least two independent experiments and a minimum n = 10-15 cells per 

condition per experiment. All graphs and statistical analyses were generated using GraphPad Prism 
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software. Graphs depict the data average and the standard error of the mean (SEM). Statistical 

significance was assessed by either unpaired student’s t-test or one-way ANOVA. Significance is 

defined as *p<0.05; **p<0.01; ***p<0.001; ****p<0.0001. 
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RESULTS 

SD4 clusters GluA1 and GluA2 containing AMPARs 

To characterize the relationship between AMPARs and SD4, we used a clustering assay 

previously established within our lab14.  The full-length AMPAR subunits GluA1 and GluA2, as 

well as the kainate receptor subunit GluK2, were expressed in heterologous COS cells either alone 

or co-expressed with full-length HA-tagged SD4. GluK2 is predicted not to associate with SD4 

and served as a negative control. Each receptor subunit contains an N-terminal HA tag for 

extracellular detection. COS cells were first live-labeled with anti-HA antibodies to examine 

distribution of surface expressing GluA1, GluA2, or GluK2. The receptors have extracellular N-

termini, while SD4 does not, so only surface GluA1, GluA2, or GluK2 were labeled. After fixation 

and permeabilization, cells were stained with anti-SD4 antibodies for total SD4. 

We observed diffuse and even distribution of GluA1, GluA2, and GluK2 when expressed 

alone. When co-expressed with SD4, a change in the overall distribution of both GluA1 and GluA2 

was observed (Figure 1A). No difference was observed when GluK2 was co-expressed with SD4, 

indicating specificity of SD4 for AMPARs (Figure 1A). Quantification indicates a significant 

increase in the mean cluster size of GluA1 and GluA2 puncta when co-expressed with SD4 

compared to receptor alone (Figure 1B). Although GluK2 puncta are larger at baseline, there was 

no significant change observed in puncta size when co-expressed with SD4 (Figure 1B). 

We noted a distribution of GluA1 or GluA2 cluster sizes in SD4 co-expressing cells. To 

determine whether cluster size was related to overlap with SD4, which was not captured in the 

previous analysis, we stratified populations in co-expressing cells into two groups representing 



40 
 

glutamate receptor puncta co-localized with SD4 (w/ SD4) or not co-localized with SD4 (w/o 

SD4). Stratification of GluA1 puncta co-localized with SD4 showed that the mean cluster size is 

significantly greater when SD4 and GluA1 are co-localized compared to GluA1 expressed alone 

(Figure 1C). In contrast, the size of puncta not co-localized with SD4 were not significantly 

different compared to GluA1 alone (Figure 1C). The mean size of GluA2 clusters is also 

significantly greater when co-localized with SD4, while non-colocalized clusters are not 

significantly different compared to GluA2 alone (Figure 1D). No significant differences were 

observed in the size of GluK2 clusters co-localized with SD4 or not co-localized compared with 

GluK2 alone (Figure 1E). These results provide evidence that co-expression of SD4 is sufficient 

to re-distribute and cluster GluA1 and GluA2-containing AMPARs in heterologous cells, and the 

increased cluster size is dependent on co-localization with SD4. 

 

The proline-rich N-terminus of SD4 is dispensable for clustering with GluA1 and GluA2. 

To identify the region of SD4 sufficient for clustering with GluA1 or GluA2, we generated 

chimeric proteins by swapping domains between SD4 and the distantly related dispanin family21 

member IFITM3 with a similar topology22,23.  One chimera was generated using the N-terminus 

of SD4 and the entire membrane associated domain of IFITM3 (SD4-NTD/IF-M), and a second 

chimera was generated using the N-terminus of IFITM3 and the entire membrane associated 

domain of SD4 (IF-NTD/SD4-M) (Figure 2A; Table 1). Constructs were first verified by 

immunoblot with antibodies that only recognize the N-terminus of their respective proteins 

(Figure 2B). Therefore, signal is only present when the N-terminus is expressed.  
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GluA1 was expressed in COS cells either alone, or co-expressed with full-length SD4, 

SD4-NTD/IF-M, or IF-NTD/SD4-M (Figure 2C). We observed no difference in mean cluster size 

of GluA1 populations either co-localized or not co-localized with SD4-NTD/IF-M compared with 

GluA1 alone (Figure 2D). However, stratification of the GluA1 populations indicated a significant 

increase in the mean size of GluA1 clusters when co-localized with IF-NTD/SD4-M compared 

with GluA1 alone (Figure 2E). Next, GluA2 was expressed in COS cells either alone, or co-

expressed with either IF/SD4 chimeras (Figure 2F). Stratification of GluA2 populations co-

localized or not co-localized with SD4-NTD/IF-M resulted in no change in the mean size of GluA2 

clusters (Figure 2G). However, we observed a significant increase in the mean size of GluA2 

clusters when co-localized with IF-NTD/SD4-TM compared with GluA2 alone (Figure 2H). 

 These results indicate that the proline-rich N-terminus of SD4 is dispensable for clustering 

with GluA1 and GluA2. Furthermore, the membrane domain of SD4 is sufficient for clustering 

with GluA1- and GluA2-containing AMPARs, and that clustering of AMPARs is dependent on 

co-localization with SD4. 

 

The N-terminus of GluA1 is dispensable for clustering with SD4. 

To identify the region of GluA1 that is sufficient for clustering with SD4, we generated chimeric 

GluA1 proteins using homologous domains of GluK2 (Table 2). Expression of all GluK2/GluA1 

chimeras were verified by immunoblot (Figure 3A). The chimeras were then transfected and 

expressed in COS cells either alone or with full-length SD4 (Figure 3B-F). Quantification of mean 
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area of clusters shows an increase in puncta size when SD4 is co-expressed with GluA1, but no 

significant difference when co-expressed with the chimera expressing the M1-3, S2, M4, and CT 

domains of GluA1 (Figure 3G). However, stratification of GluK2/A1/M1-3/S2/M4/CT chimeric 

puncta (Figure 3B) depict a significant increase in puncta size when co-localized with SD4 

(Figure 3H). Therefore, we conclude that the N-terminus of GluA1 is dispensable for clustering 

with SD4, and cluster size is dependent on co-localization with SD4.  

 

The N-terminus of GluA2 is dispensable for clustering with SD4. 

We next generated GluA2 chimeras using homologous domains of GluK2 (Table 3). Expression 

of GluA2 chimeras was verified by immunoblot (Figure 4A). All chimeras were transfected in 

COS cells either alone or with full-length SD4 (Figure 4B-D). We found that only the chimera 

expressing the M1-3, S2, M4, and CT domains of GluA2 resulted in an altered distribution when 

co-expressed with SD4 (Figure 4B). Additionally, the GluK2/A2/M1-3/S2/M4 chimera, where 

the GluA2-CT domain was not present, resulted in a loss of the clustering phenotype (Figure 4C). 

Therefore, these experiments show the importance of the GluA2 C-terminal domain for clustering 

with SD4. Quantification of mean area of clusters shows a significant increase in cluster size when 

SD4 is co-expressed with either full-length GluA2 or the GluK2/A2/M1-3/S2/ M4/CT chimera 

(Figure 4E). Furthermore, stratification of puncta from Figure 4B shows a significant increase in 

puncta area only when co-localized with SD4 (Figure 4F). Therefore, we conclude that the N-

terminus of GluA2 is dispensable for clustering with SD4, and cluster size is dependent on co-

localization with SD4.  
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The M4 and C-terminus of GluA2 is sufficient for clustering with SD1. 

For comparison, we sought to identify a region of AMPAR necessary for clustering with the SD4-

related family member SD1. Full-length GluA2 had previously been observed to cluster with 

SD114, therefore, GluA2 and GluK2 were used as positive and negative controls, respectively.  We 

observed altered distribution of GluA2, but not GluK2, when co-expressed with SD1 (Figure 5A). 

Next, we co-expressed two of the key GluA2 chimeras from Figure 4. Similar to SD4, we 

observed clustering when the GluK2/A2/M1-3/S2/M4/CT chimera was co-expressed with SD1. 

However, in contrast to SD4, we also observed clustering when the GluK2/A2/M4/CT chimera 

was co-expressed with SD1 (Figure 5B). Quantification depicts a significant increase in mean 

area of clusters when SD1 is co-expressed with GluK2/A2/M1-3/S2/M4/CT and 

GluK2/A2/M4/CT, but not with GluK2 (Figure 5C). Lastly, stratification of M4, CT chimera 

puncta co-localized with SD1 results in a significant increase in the mean area of clusters (Figure 

5D). Therefore, the M4 and CT of GluA2 is sufficient for clustering with SD1.  

 

SD4 cluster size increases when colocalized with GluA1 and GluA2. 

Next, we were interested in whether co-expression of AMPARs with SD4 results in a reciprocal 

increase in the cluster size of SD4. For these experiments, SD4 was expressed in COS cells either 

alone, or co-expressed with either GluA1, GluA2 or GluK2 (Figure 6A). Stratification of SD4 

puncta co-localized with GluA1 results in a significant increase in the mean cluster size of SD4 

puncta co-localized with GluA1 compared with SD4 alone (Figure 6B). Additionally, the mean 
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cluster size of SD4 puncta co-localized with GluA2 is also significantly increased (Figure 6C). 

We observed no difference in the mean cluster size of SD4 puncta whether co-localized or non-

colocalized with GluK2 compared with SD4 alone (Figure 6D). We conclude that not only does 

co-localization of SD4 with AMPARs increase the mean cluster size of the receptor, but 

colocalization with AMPARs also significantly increase the cluster size of SD4.  

 

SD4 clustering of GluA1 and GluA2 is temperature dependent 

Clustering of GluA2 by SD1 requires a 37oC incubation after the surface labeling at 4oC14.  This 

observation suggests that a biological process such as endocytosis is necessary for clustering by 

SD1. We were then interested to determine whether SD4 clustering of AMPARs is temperature 

dependent. For these experiments, duplicate plates of COS cells expressing GluK2, GluA1, or 

GluA1 either alone or co-expressed with SD4 were prepared. For surface labeling of the receptors, 

all plates were incubated at 4oC. Next, one plate was transferred to a 37oC incubator, while the 

other plate remained at 4oC. After incubation, coverslips were fixed and imaged. We observed that 

incubation at 4oC does not result in a change of distribution for any of the receptors, either alone 

or co-expressed with SD4 (Figure 7A). Quantification indicates no significant increase in the 

mean area of clusters after the 4oC incubation (Figure 7B). However, incubation at 37oC resulted 

in clustering of the receptors as expected (Figure 7C). Quantification shows a significant increase 

in the mean area of clusters when either GluA1 or GluA2 are co-expressed with SD4, but not 
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GluK2 (Figure 7D). Therefore, we conclude that endocytosis of surface labeled AMPARs is most 

likely necessary for clustering with SD4. 

 

Proposed mechanism for SD4 role in AMPAR clustering in heterologous cells. 

We propose a mechanism by which SD4 forms a complex with GluA1 or GluA2 AMPAR subunits 

resulting in readily available pools of AMPARs (Figure 8). SD4 is translated in the nucleus and 

transported through the secretory pathway where it is exocytosed to the surface of the plasma 

membrane. However, our studies indicate that, at least in heterologous cells, SD4 remains on the 

surface only for a brief period, while most SD4 is localized intracellularly. At the plasma 

membrane, SD4 binds and captures GluA1 and GluA2 AMPAR subunits. The SD4-GluA1/A2 

complexes are then endocytosed to early endosomes where they are readily available. After 

stimulation, these readily available pools are exocytosed to the cell surface to increase the number 

of surface AMPARs which, in neurons, would then be trafficked to the synapse. These results 

further indicate a potential role for SD4 in regulating AMPAR trafficking during LTP. 
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DISCUSSION 

Previously, we showed that SD4 alters AMPAR biophysical properties in a subunit-specific 

manner19, indicating a direct and specific interaction with AMPARs. Indeed, SD4 has been 

identified in multiple independent proteomic studies as a component of AMPAR complexes13,16,17 

as well as recent structural studies of native AMPAR complexes from brain20. Although present 

in synaptosomal membranes, SD4 is de-enriched in the PSD18, suggesting that SD4 associates 

primarily with extra-synaptic AMPARs. Here we present evidence that SD4 and GluA1 or GluA2 

AMPARs bidirectionally increase cluster size of each other in heterologous cells. Distinct regions 

within SD4, GluA1 and GluA2 are critical for this mutually dependent clustering activity. 

Intriguingly, the bi-directional clustering requires incubation at 37oC, suggesting that endocytosis 

of surface labeled AMPARs is most likely necessary for clustering with SD4. We propose that 

SD4 establishes a reserve pool of extra-synaptic AMPARs through bidirectional clustering of SD4 

and AMPARs necessary for synaptic potentiation.  

SD4 is predicted to contain two membrane-bound domains, with only one that spans the 

membrane, with a large proline-rich intracellular N-terminus and a small extracellular C-

terminus18, confirmed in a recent study24.  Proline residues have often been linked to protein-

protein interactions25,26. However, our results indicate that only the membrane bound portion of 

SD4 is important for clustering with GluA1 or GluA2. Others reported that SD4 is able to co-

immunoprecipitate a small amount (2% of input) of GluA1 or GluA2 when co-expressed in 

HEK293 cells24.  Furthermore, deletion of the intracellular loop, the transmembrane domain, and 

the small extracellular tail of SD4 eliminated the observed co-immunoprecipitation24, consistent 
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with our results indicating that the proline-rich intracellular N-terminal region is not required for 

clustering.  SD4 does not contain a PDZ binding motif, and it is not enriched in the PSD18. The 

proline-rich domain may be important for interaction with other auxiliary factors or scaffolds 

necessary for trafficking and anchoring at synapses. Additional experiments will address this 

possibility.  

To identify the GluA1 AMPAR domain sufficient for clustering with SD4, we used 

GluK2/GluA1 chimeras which swap homologous protein domains between receptors. All 

GluK2/GluA1 chimeras lacked the NT domain of GluA1. The total mean area of GluA1 puncta 

was not significantly larger compared to the chimeras when co-expressed with SD4. However, we 

did observe some clustering with the GluK2/A1/M1-3/S2/M4/CT chimera when expressed alone, 

which may have occluded any increase in cluster size in this analysis. In support of this possibility, 

the mean cluster size of GluK2/A1/M1-3/S2/M4/CT chimeric puncta are significantly increased 

by stratification of puncta co-localized with SD4, while no increase is observed by stratification 

of other chimeras co-localized with SD4. We observed altered distribution of the receptor only 

when the entire membrane, S2, and CT domains (GluK2/A1/M1-3/S2/M4/CT) were present and 

co-localized with SD4 in COS cells. Therefore, we conclude that the NT domain is dispensable, 

while the entire membrane bound domain of GluA1, in addition to the S2 and CT domains, are 

necessary for clustering by SD4. 

Similar to the GluA1 chimeras, we used GluK2/GluA2 chimeras to identify the region 

sufficient for clustering with SD4. All GluK2/GluA2 chimeras lacked the NT domains of GluA2. 

We observed a change in distribution when the entire membrane bound domain, S2 domain, and 
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CT domain of GluA2 (GluK2/A2/M1-3/S2/M4/CT) was expressed with SD4. In these 

experiments, we also saw a significant increase in mean puncta size, with no significant differences 

with any additional chimeras. Interestingly, we observed that clustering was lost when the CT 

domain was absent, indicating an importance of the CT for clustering with SD4. Additionally, we 

did not observe clustering when the M1-3 and S2 domains were absent. We conclude that the 

entire membrane bound domain of GluA2, in addition to the S2 and CT domains, is necessary for 

clustering by SD4. 

Interestingly, we observed that GluA1 and GluA2 also affected cluster size of SD4 when 

co-expressed in COS cells. These results coincide with an increase in cluster size when stratified 

for co-localization with GluA1 or GluA2. We conclude that the cluster size of both SD4 and 

AMPAR puncta is significantly increased only when co-localized in COS cells, indicating a bi-

directional interaction mechanism. 

We were not able to identify a smaller domain of GluA1 or GluA2 sufficient for clustering 

with SD4. One possibility is that there are multiple regions within the AMPAR necessary for 

interacting with SD4. Pioneering work by Ben-Yaacov and colleagues using domain swaps 

demonstrated AMPAR interaction with Stargazin/TARP-γ2 primarily involves the AMPAR 

membrane domains M1 and M4 of neighboring subunits, with important contributions by the CT11. 

Structural studies with cryo-EM support these functional results27-29. Attempts to express three 

constructs in COS cells were technically problematic, therefore, we could not pursue this approach. 

Since SD4 has been shown to affect the biophysical properties of GluA1 and GluA2-contating 

AMPARS19, in future experiments we plan to continue the structure-function approach with 
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electrophysiology to narrow down the critical domain.  Moreover, cryo-EM structures of native 

AMPARs indicates that SD4 is associated with AMPAR complexes that contain TARP-γ8 and 

CNIH-220. Thus, it will be interesting to determine if SD4-dependent AMPAR clustering is 

influenced by the presence of TARP-γ8 and/or CNIH-2, or whether SD4 clusters bi-directionally 

with either of these two auxiliary factors. Furthermore, the co-expression of multiple auxiliary 

subunits might increase the efficiency of co-immunoprecipitation of AMPAR subunits observed 

with SD4 alone24.  It should be noted that clustering of AMPARs required co-expression of 

Stargazin/TARP-γ2 and PSD-95; Stargazin/TARP-γ2 alone was not sufficient to change the 

distribution of AMPARs in heterologous cells8. Thus, the mutually dependent clustering activity 

of SD4 with AMPARs might be unique to this auxiliary factor.  

Intriguingly, the bi-directional clustering requires incubation at 37oC, suggesting that 

endocytosis of surface labeled AMPARs is most likely necessary for clustering with SD4. In 

primary hippocampal neurons at steady-state most of SD4 overlaps with endosomal markers24, but 

some protein is available for surface labeling18,24. Thus, it is tempting to speculate that SD4 

captures AMPARs at the plasma membrane for clustering via transport through an endocytic 

compartment. Current studies are addressing this possibility. Importantly, the increased cluster 

size of GluA1 that overlaps with SD4 is observed in primary hippocampal neurons upon chemical-

LTP, suggesting that this clustering activity is a mechanism underlying strengthening of synapses 

during synaptic plasticity. We propose that SD4 establishes a reserve pool of extra-synaptic 

AMPARs through bidirectional clustering of SD4 and AMPARs necessary for synaptic 

potentiation. 
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We were able to identify a minimal domain of GluA2 domain responsible for the 

interaction with the related protein SD1. SD4 and SD1 share approximately 35% overall amino 

acid sequence similarity, with higher similarity occurring within the membrane bound domain14.  

However, while SD4 and SD1 share similarity only SD4 has been shown to affect the biophysical 

properties of GluA1 and GluA2-containing AMPARs15,19. Co-expression of GluA2 with SD1 

shows significant clustering of GluA2 when compared to GluA2 expression alone, which fits with 

previously observed results14.  Conversely, co-expression of GluK2 with SD1 did not exhibit a 

clustering phenotype. Using the same GluK2/GluA2 chimeras, we observed clustering of the 

GluK2/A2/M1-3/S2/M4/CT chimera when co-expressed with SD1. In contrast to SD4, we also 

observed clustering when SD1 was co-expressed with the GluK2/GluA2 chimera expressing only 

the M4 and CT domain of GluA2. We conclude that the minimal M4/CT domain of GluA2 is 

sufficient for clustering with SD1, which potentially explains the lack of SD1 effects on 

biophysical properties.  

Most of the excitatory transmission in the brain is mediated by AMPA receptors. 

Furthermore, many neuropsychiatric and neurological disorders, such as Alzheimer’s disease and 

depression, can be characterized by abnormal AMPA receptor content and trafficking leading to 

impaired synapse function30-32. Therefore, understanding the complete mechanism behind AMPA 

receptor function is important for understanding disease. Continuing studies utilizing cultured 

hippocampal neurons and transgenic mouse models will be important to establish the role of SD4 

trafficking to the synapse that may yield a better understanding of the underlying mechanism 

behind neuropsychiatric and neurological disorders. 
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Figure 1. SD4 clusters GluA1 and GluA2-containing AMPARs. 

(A) Representative confocal images of COS cells transfected with either receptor alone, or co-

transfected with both receptor and SD4. Cells were live labeled with anti-HA antibodies against 

surface expressing receptors and anti-SD4 antibodies for total SD4. Scale bar = 20 µm. (B) Graph 

depicts mean cluster size of GluA1 alone (n=10), GluA1 + SD4 (n=12), GluA2 alone (n=16), 

GluA2 + SD4 (n=10), GluK2 alone (n=13), or GluK2 + SD4 (n=11) puncta. (C-E) Graphs depict 

stratification of GluA1 (C), GluA2 (D), or GluK2 (E) puncta either co-localized or not co-localized 

with SD4 compared to the average cluster size of receptor alone. Data are represented as mean 

cluster size +/- SEM; n.s. not significant; **p<0.01; ***p<0.001; ****p<0.0001; one-way 

ANOVA. 
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Figure 2. The proline rich N-terminus of SD4 is dispensable for clustering with GluA1 and 

GluA2. 

(A) Schematic depicting the chimeric protein structures. Chimeras were generated expressing 

either (i) the N-terminus of SD4 and membrane domain of IFITM3 (SD4-NTD/IF-M) or (ii) the 

N-terminus of IFITM3 and membrane domain of SD4 (IF-NTD/SD4-M) (See Table 1 of 

Methods). (B) Immunoblot of COS cell lysates transfected with SD4 and IFITM3 chimeras. β-

Tubulin was used as the loading control. (C) Representative confocal images depict either GluA1 

expressed alone or co-expressed with either IF/SD4 chimera. Scale bar = 20 µm. (D, E) Graph 

depicts mean cluster size of GluA1 puncta from stratification of GluA1 co-localized or not co-

localized with SD4-NTD/IF-M chimeras (D) or IF-NTD/SD4-M chimeras (E) compared with 

GluA1 alone. GluA1 alone (n=10), GluA1 + SD4-NTD/IF-M (n=12), and GluA1 + IF-NTD/SD4-

M (n=12). (F) Representative confocal images of GluA2 alone or co-expressed with IF/SD4 

chimeras. Scale bar = 20 µm. (G, H) Graph depicts mean cluster size of GluA2 puncta from 

stratification of GluA2 co-localized or not co-localized with SD4-NTD/IF-M chimeras (G) or IF-

NTD/SD4-M chimeras (H) compared with GluA2 alone. GluA2 alone (n=13), GluA2 + SD4-

NTD/IF-M (n=12), and GluA2 + IF-NTD/SD4-M (n=16). Data are represented as mean cluster 

size +/- SEM; n.s. not significant; *p<0.05; **p<0.01; ****p<0.0001; one-way ANOVA. 
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Figure 3. The N-terminus of GluA1 is dispensable for clustering with SD4. 

(A) Immunoblot depicting expression of GluK2/GluA1 chimeras. Homologous domains of GluA1 

were inserted into the backbone of GluK2 (See Table 2 of Methods). β-Tubulin was used as the 

loading control. (B-F) Representative confocal images of COS cells transfected with either a 

GluK2/A1 chimeric receptor alone, or co-transfected with SD4. Scale bar = 20 µm. (G) Graph 

depicts mean area of clusters when GluK2, GluA1, and each GluK2/A1 chimera is expressed either 

alone or co-expressed with SD4. (H) Graph depicts mean cluster size of M1-3, S2, M4, CT chimera 

stratified for either co-localized or not co-localized with SD4. M1-3, S2, M4 alone (n=11), M1-3, 

S2, M4 w/o SD4 (n=13), M1-3, S2, M4 w/ SD4 (n=13). Data are represented as mean +/- SEM; 

n.s. not significant; *p<0.05; ****p<0.0001; one-way ANOVA. 

 

 

 

 

 

 

 

 

 



57 
 

 



58 
 

Figure 4. The N-terminus of GluA2 is dispensable for clustering with SD4. 

(A) Immunoblot depicting expression of GluK2/GluA2 chimeras. Homologous domains of GluA2 

were inserted into the backbone of GluK2 (See Table 3 of Methods). β-Tubulin was used as the 

loading control. (B-D) Representative confocal images of COS cells transfected with either a 

GluK2/A2 chimeric receptor alone, or co-transfected with SD4. Scale bar = 20 µm. (E) Graph 

depicts mean area of clusters when GluK2, GluA2, and each GluK2/A2 chimera is expressed either 

alone or co-expressed with SD4. (F) Graph depicts mean area of M1-3, S2, M4, CT chimera 

clusters stratified for either co-localized or non-colocalized with SD4. M1-3, S2, M4, CT alone 

(n=14), M1-3, S2, M4, CT w/o SD4 (n=11), M1-3, S2, M4, CT w/ SD4 (n=13). Data are 

represented as mean +/- SEM; n.s. not significant; **p<0.01; one-way ANOVA. 
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Figure 5. The M4 and C-terminus of GluA2 is sufficient for clustering with SD1. 

(A) Representative confocal images of COS cells transfected with GluA2 alone, GluK2 alone, or 

co-transfected with GluA2 or GluK2 and SD1. Scale bar = 20 µm. (B) Representative confocal 

images of chimeras expressing the M1-3,S2,M4,CT and M4,CT domains of GluA2 either alone or 

co-expressed with SD1. Scale bar = 20 µm. (C) Graph depicts mean area of clusters when GluK2, 

GluA2, and each GluK2/A2 chimera is expressed either alone or co-expressed with SD1. (D) 

Graph depicts mean area of M4, CT chimera clusters stratified for either co-localized or non-

colocalized with SD1. M4, CT alone (n=13), M4, CT w/o SD1 (n=13), M4, CT w/ SD1 (n=11). 

Data are represented as mean +/- SEM; n.s. not significant; *p<0.05; **p<0.01; ***p<0.001; 

****p<0.0001; one-way ANOVA. 
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Figure 6. SD4 cluster size increases when colocalized with GluA2. 

(A) Representative confocal images of COS cells expressing SD4 alone, or SD4 co-expressed with 

either GluA1, GluA2 or GluK2. Scale bar = 20 µm. (B-D) Graph depicts mean area of SD4 clusters 

stratified for either co-localized or non-colocalized with GluA1 (B), GluA2 (C) or GluK2 (D). (B) 

SD4 alone (n=12), SD4 w/o A1 (n=10), SD4 w/ A1 (n=10). (C) SD4 alone (n=12), SD4 w/o A2 

(n=10), SD4 w/ A2 (n=10). Data are represented as mean +/- SEM; n.s. not significant; *p<0.05; 

****p<0.0001; one-way ANOVA. 
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Figure 7. SD4 clustering of GluA1 and GluA2 requires incubation at 37oC. 

(A) Representative confocal images of COS cells expressing either GluK2, GluA1, or GluA2 alone 

or co-expressed with SD4 after incubation at 4oC. (B) Graph depicts mean area of receptor clusters. 

GluK2 alone (n=14), GluK2 + SD4 (n=12), GluA1 alone (n=10), GluA1 + SD4 (n=14), GluA2 

alone (n=12), GluA2 + SD4 (n=13). (C) Representative confocal images of COS cells expressing 

either GluK2, GluA1, or GluA2 alone or co-expressed with SD4 after incubation at 37oC. (D) 

Graph depicts mean area of receptor clusters. GluK2 alone (n=11), GluK2 + SD4 (n=16), GluA1 

alone (n=10), GluA1 + SD4 (n=10), GluA2 alone (n=10), GluA2 + SD4 (n=10). Data are 

represented as mean +/- SEM; n.s. not significant; *p<0.05; one-way ANOVA. 
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Figure 8. Proposed mechanism for SD4 role in AMPAR clustering in heterologous cells. 

SD4 is translated in the nucleus and transported through the secretory pathway where it is 

exocytosed to the surface of the plasma membrane. Here, SD4 binds and captures GluA1 and 

GluA2 AMPAR subunits. The SD4-GluA1/A2 complexes are then endocytosed to early 

endosomes where they are readily available. After stimulation, these readily available pools are 

exocytosed to the cell surface to increase the number of surface AMPARs which, in neurons, 

would then be trafficked to the synapse. 
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Chapter 3 

 

Surface trafficking and synaptic targeting of GluA1-containing AMPARs is impaired in 

SynDIG4/PRRT1-knockout hippocampal neurons 

 

Preface: 

This chapter represents preliminary data and results that will be included in a future manuscript. 

All experiments are planned to be replicated by Chun-Wei (Jay) He and will contribute to this 

manuscript, as well as his future dissertation. In this chapter, I performed all cultures of 

hippocampal neurons and immunochemistry experiments, as well as data analysis. Hector H. 

Navarro and Alma Peraza were instrumental in blinding confocal images and performing data 

analysis. 
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ABSTRACT 

LTP is abolished by single tetanus stimulation of hippocampal slices from SD4-KO animals.  We 

used WT and SD4-KO mice to study SD4 regulation of GluA1-containing AMPARs in 

hippocampal neurons.  We observed a significant increase in co-localization of SD4 with GluA1 

after glycine induced LTP. The mean size of GluA1 puncta was significantly increased when 

stratified, indicating that co-localization with SD4 increases synaptic GluA1 cluster size during 

LTP.  We used WT and SD4 KO mice to study SD4 regulation of GluA1-containing AMPARs in 

hippocampal neurons.  To study GluA1-containing AMPARs during LTP, we used glycine induced 

chemical LTP on WT and KO neurons. After chemical LTP, WT neurons show a 2-fold increase in 

synaptic GluA1, while synaptic GluA1 is unchanged in SD4-KO neurons. We rescued this 

impairment by transfecting KO neurons with WT SD4 to restore the reserve pool of extra-synaptic 

GluA1, suggesting the effect is a direct result of the loss of SD4. Lastly, we observed a 50% 

increase in synaptic SD4 density, indicating synaptic targeting of SD4 to synapses during LTP. 

Given that LTP requires a reserve pool of AMPARs1, these data are consistent with a model 

whereby SD4 establishes an extra-synaptic reserve pool of GluA1-containing AMPARs required 

for LTP. 
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INTRODUCTION 

From birth, our brains begin to grow and form new connections as a result of the innate ability of 

the central nervous system to adapt and grow in response to stimuli2-5. For decades neuroscientists 

have been studying the mechanisms by which the brain is able to change and adapt in response to 

experience, a process known as experience-dependent plasticity. Therefore, neuronal plasticity is 

a crucial aspect of brain function. Furthermore, understanding exactly how plasticity within the 

brain is carried out may be important for treatment of pathological conditions such as Epilepsy and 

Alzheimer’s disease, where abnormalities in neuronal plasticity have been observed6.  

Characterizing the mechanisms by which neuronal plasticity is regulated will be important for the 

development of future therapies for such diseases.  

 Specifically, neuronal communication is carried out through electrochemical signals 

transmitted through projections from the cell body, called the axon terminals7.  These axon 

terminals form connections, or synapses, with the dendrites of other neurons to transfer 

information. The ability of mature neurons to form synapses remains the traditional method by 

which neurons are able to communicate within the brain7.  Furthermore, the number of dendritic 

spines on the branches of dendrites, which limit the number of synapses that may form, has been 

directly correlated with cognitive function8,9.  Specifically, the hippocampus, one of the brain 

regions identified as a prominent regulator of cognitive functions, has been widely implicated as 

the main site of learning and memory in both mice and humans10,11.  Importantly, the ability of the 

hippocampus to change over time has been regarded as a key characteristic underlying cognitive 

function, including memory formation11-13. Previous studies have shown that changes in synaptic 
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plasticity are directly correlated with changes in dendritic spine number/density14.  Therefore, the 

formation and elimination of individual dendritic spines further underlies synaptic plasticity within 

the brain. 

As the hippocampus is one of the most dynamic regions within the brain, hippocampal 

neurons were an attractive model for studying spine plasticity and morphogenesis15,16.              

Glutamate receptors predominantly regulate the synaptic communication of excitatory neurons in 

the brain35,36.  During synaptic transmission, pre-synaptic axon terminals responsible for export of 

signaling molecules pair with post-synaptic dendritic spines17-21. The pre-synaptic bouton contains 

hundreds of synaptic vesicles (SVs), which dock at the plasma membrane prior to synaptic 

activity17,21,22. These SVs then fuse with the membrane, allowing the export of cell signaling 

molecules, such as glutamate, across the synapse. Dendritic spines are densely populated with 

proteins that include glutamate receptors and ion channels which allow for the binding of 

molecules during synaptic transmission18,21,23. Therefore, signals received from pre-synaptic 

neurons trigger signaling cascades which dictate neuronal activity.  

The goal of this study is to further establish a role of SD4 in regulating GluA1-containing 

AMPARs in primary hippocampal neurons. We hypothesize that SD4 and surface GluA1 are 

primarily localized at extra-synaptic sites, while the loss of SD4 results in altered localization and 

trafficking. Furthermore, we predict a role of SD4 in synaptic trafficking of GluA1. This study 

indicates that both surface and synaptic trafficking of GluA1 is impaired in SD4-KO neurons at 

baseline and during glycine induced LTP. Therefore, our results further establish a mechanism for 

the role of SD4 in regulating hippocampal surface GluA1. 
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MATERIALS/METHODS 

 

Animals 

C57BL/6 mice were bred in house and maintained in the animal facility at UC Davis. Additional 

Sprawg Dawley rats were obtained from ENVIGO. The use and maintenance of animals were 

carried out according to the guidelines set forth by UC Davis, the NIH, and AALAC. 

 

Antibodies 

The following antibodies were used: mouse IgG2a anti-SynDIG4 [NeuroMab; Cat# 73-409; 

RRID: AB_2491106; Immunocytochemistry (ICC) 1:200; Immunoblotting (IB) 1:2000]; rat anti-

hemagglutinin (HA) (Roche; ICC 1:50; IB 1:1000); Guinea pig anti-vGlut1 (ICC 1:500); Alexa 

488-conjugated anti-mouse IgG2a (Molecular Probes; ICC 1:200); Alexa 594-conjugated anti-rat 

(Jackson ImmunoResearch; ICC 1:200); and Alexa 649-conjugated anti-guinea pig (Jackson 

ImmunoResearch: ICC 1:500).   

 

Constructs 

Full length version of rat SD4 coding sequence was amplified by PCR from pHM6 expression 

vector24 and subcloned into pRK5 vector backbone provided by our collaborator Yael Stern-Bach 

at the Hebrew University of Jerusalem. For surface labeling of SD4, a double tagged FLAG-SD4-

HA construct was generated by sequential PCR amplification using megaprimers.  
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Cell culture 

Hippocampal cultures were generated from either P0-P2 mice, or E18 rat embryos. All 

cultures used the Banker protocol, requiring the culture of an astrocyte feeder layer isolated from 

rat cortex and grown to 70 – 90% confluency before dissection in astrocyte plating medium (APM) 

containing 1X MEM, 10% donor horse serum, 0.6% glucose, and 5 mL pen/strep. Prior to 

dissection, coverslips were etched with 1 M nitric acid and sterilized. Coverslips were then coated 

with 1 mg/mL poly-L-lysine (PLL) diluted in distilled water and incubated overnight at 37oC. 

After incubation, coverslips were washed 3 times with distilled water. Dissection and plating of 

hippocampal neurons was carried out as previously described. Neurons were first cultured in 

Neuronal Plating Media (NPM) containing 1X MEM, 10% donor horse serum, 0.45% glucose, 5 

mL sodium pyruvate, and 5 mL pen/strep. Astrocyte media is changed during plating using 

neuronal maintenance media (NMM) containing 1X neurobasal, 10 mL Glutamax, 5 mL sodium 

pyruvate, and 5 mL pen/strep. After 6 hours neurons are transferred to astrocyte feeder layer. After 

4 days the anti-mitotic AraC was added at a final concentration of 5 µM. A half volume change of 

the NMM was performed every 5 days. Neurons were fixed and stained at DIV 12 – 14 depending 

on confluency and maturity. 

 

Immunocytochemistry 

For primary hippocampal neurons, we surface labeled GluA1 to establish surface 

localization. For surface labeling of GluA1, neurons were fixed with 4% PFA for 5 minutes at 
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room temperature. Neurons were then washed 3 times with PBS and stained with anti-GluA1 

primary antibody diluted in PBS with 3% BSA for 1.5 hours. Cells were washed with PBS shaking 

for 5 minutes each and then permeabilized with 0.1% triton for 15 minutes. Neurons were blocked 

with 10% BSA for 30 minutes. Neurons were then stained for total anti-SynDIG4 and total anti-

vGlut1 overnight in 3% BSA at 4oC. After incubation, coverslips were washed 3 times with PBS 

and incubated in secondary antibodies for each marker for 1 hour at room temperature. Neurons 

were then washed 3 times with PBS and mounted on glass coverslips for imaging. 

 

Chemical LTP Induction 

Primary hippocampal neurons were cultured to DIV 12 – 14. Neurons were equilibrated in 

artificial cerebrospinal fluid (aCSF) containing 2 mM magnesium (Mg+2) and 2 mM Calcium 

(Ca+2) at 37oC in incubator for 30 minutes. Neurons were washed with PBS and replaced with 

aCSF containing the treatment buffer, or a DMSO mock treatment control buffer. The aCSF 

treatment buffer contains 2 mM Ca+2, 200 µM Glycine, 20 µM Bicuculine, and 3 µM Strychnine. 

Strychnine was diluted in DMSO for storage, so the equivalent volume as added to the control 

treatment. Glycine and bicuculine were diluted in water, so an additional equivalent volume was 

also added to the control. Neurons were incubated at 37oC for 5 minutes for chemical-LTP 

induction. Coverslips were then transferred to a recovery buffer (aCSF w/ Mg+2; No Drugs) for 20 

mins at 37oC. Coverslips were fixed at 4% for 5 minutes at room temperature prior to surface 

labeling. 
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Image Analysis 

For quantitative analyses, images were taken using either an Olympus FluoView 1000 or Zeiss 

LSM510 confocal microscope with a 63x/1.5 NA oil objective with identical settings for laser 

power, photomultiplier gain, and digital offset. Pinhole (1 AU) and resolution (1024 x 1024 pixels) 

were constant for all images. 

Images were imported into image analysis software (ImageJ) to determine average size of 

clusters for each condition. Selected cells were cropped from the original pictures and saved, 

blinded, and subjected to the analysis by an individual not involved in the cell selection and 

blinding process. The threshold for each independent experiment is determined by averaging the 

thresholds of at least 25% of images. The average threshold was then applied to all images for 

analysis. Only clusters within the range of 0.1 – 3.5 µm2 were measured. After data collection and 

the unblinding process, the puncta size of all signals was subjected to statistical analysis. For 

analysis of puncta size based on co-localization with SD4 (stratification analysis), co-localization 

was defined as overlap of ≥1 pixel. For figure preparation, signals were adjusted for all panels 

within a figure by using equal linear adjustments of levels in Photoshop (Adobe Systems). 

 

Statistical analyses 

Data were collected from at least two independent experiments and a minimum n=10-15 cells per 

condition per experiment. All graphs and statistical analyses were generated using GraphPad Prism 

software. Graphs depict the data average and the standard error of the mean (SEM). Statistical 
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significance was assessed by either unpaired student’s t-test or one-way ANOVA. Significance is 

defined as *p<0.05; **p<0.01; ***p<0.001; ****p<0.0001. 
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RESULTS 

A minority of overexpressed SD4 is present on the surface of transfected hippocampal 

neurons. 

To characterize SD4 in neurons, we first cultured WT hippocampal neurons from E16 rat embryos. 

Hippocampal neurons were cultured to DIV14 and fixed with 4% PFA. As a control, we first 

labeled hippocampal neurons for surface and total GluA1-containing AMPARs (Figure 1A). 

Normalized to total, we observed that only about 56% of GluA1 is expressed on the surface of 

hippocampal neurons when normalized to control. This is consistent with previous results and 

indicates that our surface labeling protocol was successful. To label surface SD4, we utilized a 

double tagged FLAG-SD4-HA construct. This construct allows us to label both total and surface 

SD4, while separating transfected SD4 from endogenous SD4. Immunoblot from COS cell lysates 

indicate successful expression of both the FLAG and HA tags (Figure 1C). Hippocampal neurons 

were transfected using calcium phosphate and labeled for total transfected SD4 (anti-FLAG), 

surface SD4 (anti-HA), and surface GluA1 (anti-GluA1) (Figure 1D). Quantification of the ratio 

of surface to total SD4 indicates that only about 35% of SD4 is expressed at the surface (Figure 

1E). Additionally, we found a trend towards an increase in co-localization of surface GluA1 with 

surface SD4 compared to co-localization of surface GluA1 with total SD4, however this difference 

was non-significant (Figure 1F). We conclude that only a small percentage of SD4 is expressed 

at the surface of WT hippocampal neurons at any given time.  
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Co-localization of SD4 with surface GluA1 is increased after chemical-LTP. 

To test the role of SD4-dependent AMPAR clustering in synaptic plasticity, we utilized primary 

culture of dissociated rat hippocampal neurons. Neurons were treated with either vehicle (DMSO) 

or 200 µM glycine in aCSF without magnesium at 37oC for 10 minutes to induce chemical-LTP. 

Neurons were then transferred to aCSF recovery buffer for 20 minutes and then live-labeled for 

surface expressing GluA1-containing AMPARs at 37oC for 1 hour. Neurons were then fixed, 

permeabilized, and stained for total SD4, surface GluA1 (sGluA1), and vGlut1 (Figure 2A). The 

number of sGluA1 puncta per cell increased by 50% after glycine treatment compared to vehicle 

(vehicle: 907+/-121, n = 12; glycine: 1362+/-142, n = 10; p-value = 0.0043), indicating successful 

chemical-LTP induction. We observed a significant increase in the co-localization of SD4 with 

sGluA1 after glycine induced LTP (Figure 2B). Additionally, we saw a significant increase of 

SD4 co-localized with the pre-synaptic marker vGlut1, as well as an increase in co-localization of 

all three markers after chemical-LTP (Figure 2B). This result indicates that at least a percentage 

of SD4 redistributes to the synapse during glycine induced chemical-LTP.  

Next, we looked at changes in the mean area of GluA1 clusters as a result of chemical-

LTP. We stratified these data to determine whether changes in the size of these clusters are 

dependent on co-localization with SD4. We observed that there was no change in the mean area 

of GluA1 clusters not colocalized with SD4 after treatment with glycine compared with vehicle 

(Figure 2C). Interestingly, there was a significant increase in the size of GluA1 clusters during 

vehicle treatment only when GluA1 was co-localized with SD4. Furthermore, we observed a 

significant increase in the mean area of GluA1 clusters co-localized with SD4 after glycine induced 
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chemical-LTP (Figure 2C). As a result of these experiments, we conclude that co-localization of 

SD4 with sGluA1 increases after chemical-LTP, and this co-localization results in an increase in 

the mean area of GluA1 clusters. 

 

Surface GluA1 distribution is altered in SD4-KO neurons. 

To test the necessity of SD4 for the distribution of sGluA1, we cultured hippocampal neurons from 

either WT or SD4-KO mice. Hippocampal cultures were labeled for total SD4, sGluA1, and 

vGlut1 (Figure 3A). We observed an increase in the synaptic density of sGluA1 in SD4-KO 

neurons as well as an increase in the extra-synaptic density of sGluA1 (Figure 3B). These changes 

in density of sGluA1 were non-significant, however there is a clear trend indicating a difference 

between WT and KO animals. Further experiments and an increase in the number of neurons for 

analysis will be necessary to determine significance. Additionally, we looked at the sGluA1 puncta 

area and observed a significant decrease in extra-synaptic sGluA1, but no significant difference in 

synaptic sGluA1 in SD4-KO neurons (Figure 3C). Lastly, analysis of the sGluA1 puncta 

integrated density shows no significant change in synaptic or extra-synaptic sGluA1 integrated 

density in SD4-KO neurons (Figure 3D).  

 

Proposed mechanism for SD4 role in AMPAR trafficking during LTP. 

In wildtype hippocampal neurons, SD4 preferentially co-localizes with GluA1-containing 

AMPARs at extra-synaptic sites (Figure 4). During LTP, the total number of SD4 does not change, 
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while surface GluA1 is increased. Additionally, the number of synaptic SD4 and GluA1 puncta 

are increased, indicating that at least a small number of SD4 puncta traffic to the synapse with 

GluA1 during LTP. In SD4-KO neurons, the number of baseline extra-synaptic surface GluA1 

puncta is significantly increased at non-synaptic localizations. After LTP, the synaptic trafficking 

of surface GluA1-containing AMPARs is impaired, which may impact the synaptic targeting of 

GluA1. Therefore, we conclude that SD4 is important for maintaining extra-synaptic surface 

GluA1-containing AMPARs, while the absence of SD4 results in an increased extra-synaptic pool 

at baseline, but decreased synaptic trafficking of GluA1 necessary for LTP. 
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DISCUSSION 

From these experiments, we observed an increased cluster size of GluA1 that overlaps with SD4 

in primary hippocampal neurons upon chemical-LTP, suggesting that this clustering activity is a 

mechanism underlying strengthening of synapses during synaptic plasticity. It is important to note 

that our experiments utilize stratified data, therefore, we are able to identify SD4 co-localized with 

surface GluA1 at extra-synaptic and synaptic localizations.  As most studies look at total surface 

GluA1, we can separate total surface GluA1 into these sub-categories to get a better picture of 

differences in co-localization of SD4 and surface GluA1 at baseline and after LTP.  We propose 

that SD4 establishes a reserve pool of extra-synaptic surface AMPARs through bidirectional 

clustering of SD4 and AMPARs necessary for synaptic potentiation.  

A recent study demonstrated overlap of SD4 with early endosomes in hippocampal 

neurons25, consistent with its role in clustering AMPARs that have been internalized. Interestingly, 

our data show that cluster size of GluA1 that overlaps with SD4 is also increased, but only at extra-

synaptic sites at both baseline and in primary hippocampal neurons upon chemical-LTP.  After 

considering the importance of endocytosis for sGluA1-SD4 co-localization, our current model 

states that SD4-induced clustering of AMPARs occurs intracellularly after endocytosis to establish 

a reserve pool of intracellular extra-synaptic AMPARs.  The number of extra-synaptic receptors 

available for synaptic trafficking must be carefully regulated, which may be the cause of the 

increase in number of sGluA1 receptors at extra-synaptic pools. sGluA1 can then be deployed to 

the synapse during LTP.  However, in SD4-KO hippocampal neurons show deficits in synaptic 

trafficking during LTP, even though the number of available extra-synaptic sGluA1 has increased.  
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Therefore, we conclude that SD4 regulates the number of available sGluA1 at extra-synaptic pools, 

and that a loss of SD4 results in impaired synaptic trafficking of these receptors. 

In addition, others have shown that SD4-KO mice are deficient for LTD26; thus, the 

intracellular clustering of AMPARs could also be employed during LTD as a mechanism to restrict 

the surface accumulation of AMPARs perhaps upon differential regulation. Additional 

experiments beyond the scope of this study are needed to investigate the effects of SD4 on AMPAR 

trafficking in neurons during synaptic plasticity. 

Our results demonstrate the effects of SD4 on clustering both GluA1 and GluA2 in 

heterologous cells. Although SD4 induces clustering of GluA1- and GluA2-AMPARs in 

heterologous COS cells, in SD4-KO neurons we observed a significant reduction in both extra-

synaptic GluA1 and extra-synaptic GluA12 puncta density27,28.  As GluA1/2 heteromers constitute 

95% of AMPARs at an extra-synaptic AMPAR pool under baseline conditions29.  This may 

suggest that SD4 is required to regulate an extra-synaptic pool of GluA1 and GluA2, while an 

absence of SD4 leads to a build-up of surface extra-synaptic AMPARs. Certain effects of SD4 

were specific for GluA1. For example, puncta size and intensity of both extra-synaptic and 

synaptic GluA1 (but not GluA2) were slightly reduced in SD4 KO neurons27, indicating an 

additional role for SD4 in regulating GluA1.  These results fit our proposed model where in SD4-

KO neurons, the loss of SD4 leads to an increase in extra-synaptic surface GluA1 and an overall 

decrease in trafficking and number of synaptic GluA1 receptors. 

GluA1 homomers account for most, if not all, calcium-permeable AMPARs (CP-

AMPARs) in the hippocampus, which are largely absent at PSDs under basal conditions; however, 

under certain conditions, CP-AMPARs become transiently detectable at postsynaptic sites 
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including the induction of LTP30 and LTD31. Thus, it is tempting to speculate that SD4 might 

establish reserve pools of GluA1 homomers that are transiently targeted to synapses during 

synaptic plasticity. 

Previous studies have shown a decrease in surface GluA1 and GluA2 after a loss of other 

auxiliary factors1,32.  Interestingly, in SD4-KO neurons, we observed  a significant increase in 

surface AMPARS at extra-synaptic sites which leads to decreases in synaptic GluA1 and deficits 

in LTP1,33.  From this study, we observed a significant increase in extra-synaptic pools of GluA1-

containing AMPARs in SD4-KO animals.  Furthermore, there is a decrease in synaptic GluA1, a 

decrease in co-localization of SD4 and GluA1, and inhibition of LTP33.  Again, it is important to 

note that these previous studies look at total surface GluA1, while our data is stratified into synaptic 

and extra-synaptic puncta.  One potential caveat of these experiments could be that since synaptic 

GluA1 is decreased, the effects on LTP could just be effects of a lack of GluA1 to begin with.  

Additional experiments using an acute KD of SD4 may be necessary to investigate this possibility.  

Furthermore, the study by Granger et al. showed the importance of the extra-synaptic pool of 

AMPARS1.  They observed that if you knockout all hippocampal AMPARs and replace them with 

Kainate receptors, LTP is rescued.  Therefore, the type of receptor is not necessarily important, 

but the mechanisms or auxiliary factors (i.e. SD4) by which these extra-synaptic and synaptic 

receptors are regulated, maintained, and trafficked is crucial.  These results fit with my 

observations whereby SD4-KO results in a build-up and increased number of surface GluA1 at 

extra-synaptic pools28.  Lastly, previous studies have shown that SD4 has a direct effect on the 

gating properties of GluA1 when co-expressed in Xenopus oocytes, indicating a direct 



87 
 

interaction28,34.  However, it is still possible that there may be a tertiary binding partner in neuronal 

systems.  In addition to my results, these data provide strong evidence that SD4 functions as a true 

auxiliary factor which modulates both the trafficking and biophysical properties of GluA1- and 

GluA2-containing AMPARs. 
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Figure 1. A minority of overexpressed SD4 is present on the surface of transfected 

hippocampal neurons. 

(A) Representative confocal images of WT rat hippocampal neurons and selected dendritic 

stretches DIV14. (B) Quantification of surface GluA1 puncta normalized to total GluA1 punctate 

represents the relative number of GluA1 puncta expressed on the surface of hippocampal dendrites. 

(C) Representative immunoblot shows expression of the double tagged FLAG-SD4-HA construct 

and specificity of the FLAG and HA antibodies. (D) Representative confocal images of WT rat 

hippocampal neurons transfected with a double tagged FLAG-SD4-HA construct. Neurons were 

stained for anti-FLAG (total SD4), anti-HA (surface SD4), and anti-GluA1 (total GluA1). (E)  

Quantification of the number of surface SD4 puncta normalized to total SD4 puncta. (F) 

Quantification of either total SD4 or surface SD4 co-localized with total GluA1. N=15 cells per 

condition. Data represented as mean +/- SEM; n.s., non-significant; t-test. Scale bar = 5 µm. 
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Figure 2. Co-localization of SD4 with surface GluA1 is increased after chemical-LTP. 

(A) Representative confocal images of dendritic stretches from primary rat hippocampal neurons 

DIV13 with replicate experiments. Neurons were treated with either a mock DMSO vehicle 

control, or 200 µM glycine in aCSF w/o magnesium at 37oC for 10 minutes. Neurons were 

transferred to aCSF recovery buffer (no drugs) for 20 minutes and then live-labeled for surface 

expressing GluA1-containing AMPARs at 37oC for 1 hour. Neurons were then fixed, 

permeabilized, and stained for total SD4, surface GluA1, and vGlut1. (B) Quantification of co-

localization between SD4, GluA1, and vGlut1. Overlap with pre-synaptic vGlut1 indicates a 

synaptic localization, while no overlap indicates extra-synaptic. (C) Quantification of mean area 

of GluA1 clusters either co-localized or non-colocalized with SD4 after treatment with vehicle or 

glycine. n=15 cells per condition. Data represented as mean +/- SEM; n.s., non-significant; 

*p<0.05; ***p<0.001; ****p<0.0001; one-way ANOVA; Scale bar = 5 µm. 

 

 

 

 

 

 

 



91 
 

 

 

 

 

 

 



92 
 

Figure 3. Surface GluA1 distribution is altered in SD4-KO neurons. 

(A) Representative confocal images of dendritic stretches from either wildtype (WT), or SD4-

knockout (KO) mouse hippocampal neurons DIV14. Neurons were first live labeled for surface 

GluA1. (B-D) Graphs depict puncta density (B), area (C), and integrated density (I.D.) (D) of 

synaptic (defined as overlap with vGlut1) and extra-synaptic sGluA1 (no overlap with vGlut1). 

Data represented as mean +/- SEM; n.s., non-significant; **p<0.01; one-way ANOVA (C, D). 

Scale bar = 5 µm. 
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Figure 4. Proposed mechanism for SD4 role in AMPAR trafficking during LTP. 

Basal levels of extra-synaptic surface GluA1 are increased in SD4-KO neurons compared to WT. 

LTP induction of WT and SD4-KO neurons indicates SD4 may be necessary for surface trafficking 

of GluA1-containing AMPARs. SD4-KO neurons also result in a loss of surface GluA1 trafficking 

to pools of extra-synaptic GluA1-containing AMPARs. 
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Chapter 4: 

 

Conclusions and Future Directions 

 

Summary and Conclusions 

The purpose of this study is to further characterize the AMPAR auxiliary protein SynDIG4/Prrt1 

and its role in binding and trafficking of GluA1- or GluA2-containing AMPARS during LTP.  In 

this study, we first confirmed the ability of SD4 to cluster GluA1- and GluA2-containing AMPARs 

in heterologous COS cells.  We then aimed to further identify a specific domain of SynDIG4 

necessary for clustering of AMPARs.  Therefore, I generated GluA1 and GluA2 AMPARs using 

the kainate receptor GluK2.  From this study, we concluded that the N-terminus of GluA1 and 

GluA2 are dispensable for binding with SD4, while the TM and CT domains are sufficient for 

clustering.  Furthermore, we observed that clustering of AMPARs by SD4 is dependent on 

endocytosis of SD4 and AMPARs, further indicating that SD4 may play a role in trafficking of 

AMPARS to and from the plasma membrane, as well as the PSD, during LTP.  Further 

experiments will be required to identify the specific mechanism of SD4 during endocytosis  

 Next, we sought to answer the question of what happens to SD4 localization before and 

after LTP.  We observed that the synaptic localization of SD4 is increased after chemically induced 

LTP.  Additionally, we observed the loss of SD4 affects localization and trafficking of GluA1 

whereby extra-synaptic sGluA1-SD4 cluster size and co-localization is increased, but LTP is 
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impaired.  This could present a possible caveat in our interpretations whereby trafficking is not an 

essential role of SD4 and is primarily responsible for maintaining AMPARs at extra-synaptic 

pools.  Therefore, deficits in clustering and LTP could simply be the result of a decrease in the 

number of readily available extra-synaptic AMPARs at the plasma membrane.  One last caveat 

may be how to accurately identify whether SD4-KO animals are increasing endocytosis or 

reducing exocytosis of GluA1/A2 AMPARs.  One method may be to use the dynasore reagent to 

inhibit endocytosis and identify changes in endocytosis events.  My data further indicates the 

overall importance of endocytosis/exocytosis for SD4 activity and AMPAR trafficking to the 

PSD1.  Endocytosis to occur I observed significant clustering of GluA1 and GluA2 AMPAR 

subunits by SD4 at 37oC, the required temperature for endocytosis.  Endocytosis and clustering is 

eliminated at 4oC, indicating the requirement of endocytosis for clustering of GluA1 or GluA2 by 

SD41. 

 

 

Future Directions 

Based on my collected data, we require several additional experiments to further elucidate 

the role of SD4 in AMPAR trafficking and gating during LTP.   Using co-immunoprecipitation, 

we can further substantiate the finding that SD4 binds to sGluA1 or total GluA1, or further attempt 

to identify any tertiary binding factor in both heterologous cells and dissociated hippocampal 

neurons.  I predict that co-expression of SD4 with GluA1 will result in a clustering phenotype as 

depicted in Figure 3. Additionally, using co-IP experiments will produce a positive GluA1 signal 
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after SD4 is pulled out of the crude lysates. From the dissociated neurons, I expect to see a 

preferential localization of SD4 with GluA1 at extra-synaptic sites as previously seen in the 

literature4. These data taken together would indicate the presence of a SD4/GluA1 complex, and 

potential interaction. Furthermore, I would conclude that this interaction is necessary for the 

extrasynaptic localization of GluA1. 

It has not been definitively established that SD4 interacts directly with GluA1. My 

preliminary results could be the result of a tertiary interaction through some intermediate AMPAR 

auxiliary protein. Therefore, it may be necessary to use both purified SD4 and GluA1 in the co-IP 

assay to further establish a definitive interaction between SD4 and GluA1.  As with the previously 

described clustering assay, heterologous COS cells will be co-expressed with GluA1 and either 

the WT control or chimeric constructs. I will use co-IP with WT and chimeric SD4 to confirm 

interaction. Lastly, I will confirm that the identified domain imparts co-localization of chimeric 

SD4 with GluA1 at extrasynaptic sites in dissociated neurons in vitro. SD4-KO neurons will be 

cultured and transfected with either WTSD4, WT-IFITM3, and each of the chimeras. Neurons will 

then be fixed, stained for HA, GluA1, and vGlut1 and imaged by confocal microscopy for analysis 

of co-localization. 

Other auxiliary factors such as Stargazin have been shown to modulate AMPARs through 

distinct and separate protein domains. Therefore, it is possible that the TM and NT of SD4 may 

also have distinct functions. It is possible that the chimeric constructs could become less stable, 

resulting in deficits in expression. To circumvent this issue, I may need to study conserved amino 
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acid residues across other species. This could allow me to identify narrow down the important 

protein domains or identify previously unknown protein motifs (SH3 motif, etc.)2, which could 

increase stability of the chimeras. Additionally, it would be of interest to generate the reverse 

chimeras to test sufficiency of these domains. Lastly, due to resolution constraints, it may be 

necessary to use additional techniques such as super-resolution or TIRF microscopy to definitively 

assess changes in protein localization. 

Previous studies using chemical LTP have shown an increase in surface GluA1 due to 

glycine treatment. It remains unclear whether SD4 will remain localized to extra-synaptic sites 

after stimulation in WT mice. If chem-LTP results in release of GluA1 from SD4, then I expect to 

see a reduction in extra-synaptic co-localization of GluA1 with SD4, as well as a reduction of 

GluA1 signal in the extra-synaptic fraction after stimulation, indicating a loss of interaction. 

However, if interaction of GluA1 with SD4 remains after chem-LTP, then I expect to see an 

increase in synaptic localization of the SD4/GluA1 complex, as well as an enrichment of SD4 and 

GluA1 in the synaptic fractions after stimulation. Potential caveat could be that increases in 

SD4/GluA1 localization could be solely due to increases in surface GluA1 due to chem-LTP. It 

will be important to additionally confirm changes in SD4 localization by co-staining SD4 with 

PSD95 and vGlut1 synapses during LTP. 

As mentioned previously, it is possible that the NT and TM of SD4 have separate functions. 

As a result, I may find that one domain is necessary for localization and interaction with GluA1, 

while the other is necessary for trafficking and LTP. Therefore, it is possible that the loss of the 

necessary SD4 domains could result in a loss of extra-synaptic GluA1 regardless of LTP induction. 
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Therefore, it will be important to further establish total versus surface GluA1 to understand where 

GluA1 is localized during LTP in the absence of SD4. Additionally, it is possible that the 

maintenance of pools of GluA1 is not unique to SD4, or that interaction between GluA1 and SD4 

is mediated through a tertiary binding protein. If a loss of SD4 does not result in deficits in surface 

GluA1 due to chemical LTP stimulus, I will investigate the involvement of additional AMPAR 

auxiliary factors.  For example, it has previously been observed that GluR4 clusters with the 

auxiliar subunit Stargazin, but only in the presence of PSD-953.  This suggests that the PDZ-

binding site of Stargazin is required to bind GluA4, and then anchor GluA4 to PSD-95 to form 

synaptic clusters3.  Does clustering of GluA1/A2 occur by SD4 through binding to Tarp-γ8 and 

being anchored by binding of Tarp-γ8 to PDZ binding site on PSD95?  SD4 has previously been 

found in complex with Tarp-γ84,5. We would try a similar experiment to assess clustering of 

GluA1/2 by SD4 through confocal imaging of GluA1/A2 expressed with SD4, or both Tarp-γ8 

and SD4 both GluA4 and Tarp-γ8 in heterologous COS cells and neuronal hippocampal cultures.   

Additionally, we could use live-imaging of heterologous COS cells and cultured 

hippocampal neurons expressing a SEP-tagged GluA1 receptors.  SEP is a super ecliptic phluorin 

which only produces GFP under neutral pH conditions.  Therefore, it has the ability to detect 

changes in pH and produce fluorescence, making it ideal for dectecting endocytosis and exocytosis 

events. We would first test SEP-GluA1 in COS cells to observe that GFP is expressing while 

insertion and removal is detected by changes in fluorescence. Therefore, we would culture 

hippocampal neurons from SD4-WT and SD4-KO expressing SEP-GluA1 with each of the 

SD4/IFITM3 chimeras and observe changes before and after chem-LTP to identify important SD4 
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protein domains. However, one caveat may be a failure of SEP-GluA1 insertion or a failure to 

increase the rate of endocytosis events.  Therefore, we may additionally look at changes in the 

motility/diffusion rates of SEP-GluA1 after chem-LTP.   

Another study used super-resolution imaging to visualize extra-synaptic pools of GluA1 

closest to the PSD6.  They observed that AMPAR nanodomains are tightly correlated with synaptic 

vesicle release where AMPAR complexes must be present directly across from the pre-synaptic 

vesicle release sites6.  This results in pools of perisynaptic GluA1, representing surface GluA1 that 

is present within the synaptic PSD, but not at vesicle release sites.  Therefore, we could use super-

resolution imaging or single particle tracking to further identify SD4 localization and co-

localization with GluA1 by further observing SD4 at synaptic and perisynaptic sites during LTP. 

Through a collaborative project with the lab of Dr.Yael Stern-Bach, we observed that the 

biophysical properties of GluA1- and GluA2-containing AMPARs were altered when co-

expressed with SD4 in Xenopus oocytes7. These changes include increases in latency and receptor 

activation, while the rate of desensitization is decreased. Changes in the gating properties of 

GluA1/A2 AMPARs were amplified further when co-expressed with Tarp-γ87.  Additionally, 

another group found that Stargazin binds, traffics, and alters the biophysical properties of 

AMPARs through two distinct protein domains8.  Utilizing chimeras generated from replacing 

specific Stargazin domains with those from Tarp-γ5, they identified two different protein domains 

responsible for trafficking and gating of GluA18,9. Therefore, we would replicate these gating 

experiments expressing GluA1 with the SD4/IFITM3 chimeras to see whether distinct protein 

domains may be identified for protein trafficking and gating.  Lastly, specific point mutations 
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within GluA2 have been found to affect the activity of CNIHs and TARPs10.  Therefore, we can 

make similar mutations within important protein domains of GluA1, GluA2, and SD4, and repeat 

clustering and biophysical experiments to further identify smaller binding sites necessary for 

trafficking and gating of AMPARs by SD4. 

Previous collaborative studies from the Diaz lab have demonstrated a role for SD4 in 

functional LTP using SD4-KO mice7. Stimulation of hippocampal slices from SD4-KO mice 

showed no increase in stable EPSPs indicating impaired LTP7.  Therefore, SD4 is important for 

functional LTP.  Functional LTP is often correlated with structural enhancements in dendritic 

spines.  During structural LTP (sLTP), AMPARs are actively recruited to synapses, resulting in a 

stable increase in spine size. It has been observed that GluA1-containing AMPARs are necessary 

for sLTP.  Additionally, our lab has found enhancements in sLTP in the absence of the related 

protein SD1, which we interpret as a lack of synapse maturation since young spines exhibit greater 

structural plasticity.  It is unclear whether SD4 is also important for GluA1-dependent sLTP.  

To establish whether SD4 is necessary for GluA1-dependent sLTP, we will use two-photon 

glutamate uncaging to stimulate individual dendritic spines in WT and SD4-KO mice.  Two-

photon glutamate uncaging is used to stimulate individual spines through the focal release of 

glutamate, resulting in the structural enhancement of the stimulated post-synaptic spine.   I will 

first extract the brains of mice at postnatal day 7.  The hippocampus will then be isolated, 

sectioned, and plated on a matrigel.  I will use a biolistic particle delivery system, or gene gun, to 

co-transfect live hippocampal slices with a GFP-expressing DNA construct to visualize CA1 

hippocampal neurons by two-photon microscopy.  Neurons will be visualized while in solution 
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containing aCSF and caged MNI-glutamate.  MNI is a light sensitive photoprotective molecule 

used to make caged ligand molecules.  When fused with glutamate, it is inactive until stimulated 

by the appropriate wavelength.  Candidate regions of interest (ROI) will be identified in GFP-

expressing neurons to be used for glutamate uncaging.  A 720 nM laser will be used to locally 

uncage MNI-glutamate, resulting in stimulation of glutamate receptors at the ROI in WT or SD4-

KO mice.  After stimulation, I will be able to assess deficits in LTP-associated spine enlargement 

in SD4-KO neurons.  To rescue deficits in sLTP, I will express GFP, WT-SD4 and each of the 

SD4/IFITM3 chimeras in slice culture. Glutamate uncaging will be used to stimulate dendritic 

spines in neurons as previously described. stimulated spines will be measured for changes in spine 

volume.   

If SD4 is necessary for GluA1-dependent sLTP, then the stimulation of spines in the KO 

mice should exhibit deficits in structural spine enhancements.  Overexpression of WT-SD4 should 

rescue these deficits on uncaging-induced spine enlargement, while neurons expressing GFP alone 

will still exhibit impairments in long-term spine enlargement.  Furthermore, if either the NT or 

TM domain is necessary for structural LTP, I expect to see impairments in the chimera where that 

domain has been replaced.  

It is possible that the SD4-KO mice will not exhibit deficits in GluA1-dependent sLTP. 

Behavioral studies using SD4-KO mice have demonstrated severe deficits in hippocampal 

dependent learning and memory.  Taken with the functional LTP studies (Figure 2), these data 

suggest that SD4 is important for hippocampal plasticity, so it is likely this would translate into 
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structural LTP.  As the mechanism of SD4-mediated sLTP is not yet known, it is unclear whether 

results from chem-LTP stimulation will correlate with changes in sLTP.  Therefore, results from 

these experiments remain mutually exclusive. 
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Appendix: 

 

Lab Protocols 

Detailed protocols have been included as an appendix to provide information on all experiments 

and to aid in future studies. 
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COS/HEK Cell Live Labeling Protocol 

Day 1: 

1. Coat coverslips with Poly-L-Lysine (PLL); 25 ug/mL in 0.1 M Borate Buffer, pH 8.5.  

Incubate coverslips at 37C for minimum 1 hr. Wash 3x with ddH20. 

2. Seed cells at desired concentration. Incubate for 24hrs. 
 

Day 2: 

3. Transfect cells and incubate for another 24 – 48 hrs. 
 

Day 3: 

4. Incubate plates on ice in 4C room for 10 mins. 
5. Prepare primary antibody in TCR hood (cold growth media, 800 uL per well, additionally 

add BSA if you get high background). 

6. Wash cells one time with cold 1x PBS. 

7. Incubate coverslips with 800 uL media plus primary antibody for 10 minutes. 

8. Prepare secondary antibody media in TCR hood. 

9. Wash coverslips three times with 1x PBS (no interval). 
10. Incubate with secondary antibody solution for 10 minutes (for fluorescent antibodies, 

be sure to cover plates). 

11. Prepare 4% PFA. 

12. Wash three times with 1x PBS. 

13. Fix plates with 4% PFA for 10 minutes at 4C. 

14. Wash coverslips three times with 1x PBS for 5 minutes each. 

15. Plates can be stored at 4oC or continue to additional staining for total protein. 

Next Steps (Total Protein): 

16. Incubate in 0.1% Triton X-100 for 15 minutes while shaking. 
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17. Block w/ 5% milk (in 1x PBS) for 30 minutes while shaking. Alternatively, can block 

with 5 – 10% BSA (IgG free). 

18. Prepare primary antibody in 5% milk (or 3% BSA). For six well coverslips, use 100 

uL per coverslip.  
19. Invert coverslips onto antibody on parafilm in foil or covered chamber and incubate at 

room temperature for 1.5 hours. 

20. Wash three times with 1x PBS for 10 minutes each. 

21. Prepare secondary antibody in 5% milk (or 3% BSA). 

22. Invert coverslips onto antibody and incubate at room temperature for 1 hour. 

23. Wash three times with 1x PBS for 10 minutes. Additionally, can include DAPI at this 

step if desired. 
24. Mount on slides with Fluoromount G (southern biotech), or other fluorescence 

protecting mounting medium. 

25. Allow to dry overnight and then seal with nail polish. 
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Defined Media Primary Neuronal Culture 

 

This protocol can be used for both mice and rats but is commonly used for mouse cultures. 

Any modifications for mouse cultures will be denoted in red.  
 

Day 1 

The day before dissection, coat nitric acid sterilized coverslips with 1 mg/mL of poly-L-lysine, 

incubate overnight at 37°C. 

**Coat coverslips on day pups are born (P0). 
 

Day 2 

1. Wash coverslips 3x with distilled water and place wax dots on coverslips 

a. Transfer coverslips to 6-well plates (at least four; 24 coverslips total) in biosafety 

cabinet. 

b. For sterility, turn on Bunsen burner and place near hot plate. Sterilize bench area 

with 70% ethanol. 

c. Begin boiling water in small beaker on hot plate at your bench. 

d. Melt wax pellets by placing pellets into a smaller beaker. 

e. Place this beaker into the water on hot plate as it begins to boil. 

f. Bring coverslips to bench. Using 200 uL pipet, carefully add wax dots to the corners 

of each coverslip. 
 

2. Transfer plates to bio-safety cabinet to dry 
 

3. Genotype mice. 

a. Use a sharpie to number each pup on the belly. 

b. Snip a small piece of the tail and transfer to individually numbered tubes. 
c. Digest tail snips to extract DNA and perform genotyping by following the Diaz Lab 

genotyping protocol. 
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d. Separate wildtype animals from knockout animals and proceed to dissection. 
 

4. Perform hippocampal dissection and plating (see following protocol for details). 

Day 6: (4DIV) 

5. Add AraC (10 mM stock; 5 uM final concentration) per well directly to culture medium 

(1:2000 dilution from stock in -20oC, i.e. 2.5 uL AraC to 5 mL NBC). 

 

Day 7: (5DIV), Day 12: (10DIV), Day 17: (15DIV), Day 21: (20DIV) 

6. Remove 700 µL of media and replace with 1 mL fresh NBC.  

 

 

 

Hippocampal Dissection and Plating 

 

1.    Before dissection, sterilize tools at 250°C for 15 minutes. 
 

2.    Decapitate P0-P2 pups, and remove brains from skull, placing in dissection buffer on ice.  
 

3.    After removing all brains, remove the hippocampi from each brain being careful to remove 

the meninges, and transfer to a 15mL conical tube on ice.  
 

4.   Transfer hippocampi to new 15 mL conical tube containing 5 mL of HBSS and 100 µL 

of 2.5% Trypsin (Gibco). 
 

*** Add 100 µL papain (Wellingsworth) to 5 mL HBSS. Warm in 37°C water bath to aid in 

dissolving. Filter sterilize before use. ***  
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5. Incubate hippocampi in 37°C water bath for 12 or 15 minutes, inverting gently every 

few minutes. 
 

6. After incubation, add 5mL of NPM. 
 

7. Centrifuge for 5 min at 1000 rpm and carefully remove the supernatant.  
 

8. Resuspend pellet in 3 mL of NPM and dissociate cells by pipetting up and down with a 

1mL pipette 3x or 5x, followed by trituration with a fire polished long stem pipette until 

most chunks of tissue have been dissociated. For best results with mouse neurons do 

not triturate with glass pipette more than 12x. If there are tissue chunks remaining, let 

them settle to the bottom of the conical tube and then remove them.  
 

9. Add NPM to a final concentration of 5-10 mLs.  
 

10. Use a hemocytometer to determine cell density (45 uL of cell suspension plus 5 uL of 

trypan blue). Trypan blue will stain dead cells blue. Do not include dead cells in your 

count. For mouse neurons, 80% of your cells should be viable at this stage. 
 

11. Dilute cells to 25,000/ mL (75,000 cells/ mL) with NPM in a separate container (make 

sure to account for pipetting error). Add 2 mLs per well, over the poly-L-lysine coated 

coverslips. This will give a final cell density of 50,000 (150,000) cells per well. 
 

12. Place dishes in incubator for 5-6 hrs.  
 

13. Replace media with NBC.  
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Media Formulations: 

 

Dissection Buffer: 

• 500 mL HBSS (remove 10 mL) 

• 5 mL HEPES 

• 5 mL Sodium Pyruvate 

 

Neuronal Plating Media (NPM): 

• 500 mL MEM (remove 68 mL) 

• 10% Donor horse serum (50mL) 

• 0.45% glucose (7.5 mL of 30% stock in DI water) 

• 5 mL Sodium Pyruvate 

• 5 mL Penicillin/ Streptomycin 

 

Neurobasal complete (NBC): 

• 500 mL Neurobasal (remove 27 mL) 

• 5 mL HEPES 

• 5 mL Sodium Pyruvate 

• 5 mL Penicillin/ Streptomycin 

• 1.5 mL L-glutamine 

 

****Filter sterilize**** 

 

• Add 10 mL B-27 after filter sterilizing 
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Additional Solutions: 

Poly-L-Lysine Solution (PLL): 

PLL stocks are at 200 mg/mL located in the -20C fridge. 

For 25 ug/mL: 

• Dilute stock at 1:8,000 in 0.1 M Borate Buffer, i.e. add 6.25 uL PLL to 50 mL 0.1M Borate 

Buffer 

For 1 mg/mL: 

• Dilute stock at 1:200 in 0.1 M Borate Buffer, i.e. add 50 uL PLL to 10 mL 0.1 M Borate 

Buffer 

 

0.1 M Borate Buffer: 

• 900 mL milli-Q water 

• 17.2 g sodium tetra-borate 

• 3.1 g boric acid 

• Adjust pH to 8.5 

• Bring up to 1 L with milli-Q water 

• Filter Sterilize 

 

1M Nitric Acid: 

• Add 64 mL 70% w/w 15.8 N nitric acid to 250 mL H20.  

• Bring up to 1000 mL. 
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Banker Style Primary Mouse Hippocampal Culture 

Wildtype and SynDIG4-knockout 

 

 

Outline: 

 

Note: For mouse cultures, astrocyte feeder layer must be timed with birth of mouse pups. 

Mouse dissection must occur at P0-P2. 

 

For astrocyte feeder layer:  

 

Day 1: Coat plates with poly-L-lysine (PLL) for astrocytes.  

 

Day 2: Plate astrocytes. 

 

Day 5: Change astrocyte plating media (APM). Continue to change APM every 3 days until pups 

are born. 
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Hippocampal neuron culture: 

 

Day 0: Perform nitric acid sterilization and etching of coverslips.  
 

Day 1: The day before dissection, coat nitric acid sterilized/etched coverslips with 1 mg/mL of 

poly-L-lysine (PLL). Replace APM media on astrocytes with 5 mL NBC. 
 

Day 2 (DIV 0): Place wax dots on coverslips for primary neurons. Genotype mice. Perform 

hippocampal dissection and plating 

 

Day 6 (DIV 4): Add 5 µM AraC to each well. 
 

Day 7: (5DIV), Day 12: (10DIV), Day 17: (15DIV), Day 21: (20DIV) 

• Perform half media change every 5 days by removing 2.5 mL old media and replacing with 

3 mL fresh NBC. 
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Sequence of events and detailed procedures: 

 

Setting up astrocyte feeder layer: 

Day 1: 

1. Coat 6-well plates with 25 µg/mL of poly-L-lysine (PLL) in 0.1 M Borate buffer. Incubate 

overnight in C02 incubator at 37oC. 
 

Day 2: 

1. Wash 6-well plates 3x with Milli-Q water. Keep in last wash until astrocytes are ready to 

be plated. 

2. Revive frozen astrocytes by thawing quickly in water bath. 1 mL of frozen astrocytes (1 

vial) will be enough for two 6-well plates. 
3. Transfer thawed astrocytes into Astrocyte Plating Media (APM), and plate 2 mL of 

suspended astrocytes per well. 

4. Place in C02 incubator. Monitor cells after 2 days, confluency should be around 20%. 

 

Day 5: 

1. Change astrocyte plating media (APM). Continue to change APM every 3 days until pups 

are born. Astrocytes should be at least 70% confluent on day of hippocampal dissection 

and plating. 
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Hippocampal Neuron Culture: 

 

Day 0: 

1. Perform nitric acid sterilization and etching of glass coverslips 

a. Place coverslips in ceramic racks and place racks in glass container.  

b. Wash coverslips 1x with Milli-Q water to remove any dust/particles. 

c. Fill container with 1M Nitric Acid (coverslips should be completely submerged.  

d. Place glass container on shaker at RT at low speed overnight. 

e. Remove Nitric Acid and save for future use (can be used up to three times). 

f. Rinse glass container and coverslips 3x with Milli-Q water (quick rinses). 
g. Fill container with Milli-Q water so coverslips are submerged and place on shaker at 

low speed 3x for 20 minutes each. Ethanol rinse to aid drying. 

h. Remove excess liquid by tapping ceramic racks on Kim-wipes. 

i. Wrap in foil and autoclave on Cycle 8 (Wrapped at 250C). 

 

Day 1: 

1. Replace APM media with 5 mL Neurobasal Complete (NBC). 

2. Coat etched/sterilized coverslips (with wax dots) with 1 mg/mL of PLL in 0.1M Borate 

buffer. Use 350 µL solution per well and bubble on top of coverslips using a 1 mL pipet. 

Incubate in the C02 incubator overnight. 

 

Day 2 (DIV 0): 

1. Wash coverslips 3x with sterile Milli-Q water. 

2. Place wax dots on coverslips.  
a. Transfer coverslips to 6-well plates (at least four; 24 coverslips total) in biosafety 

cabinet. 
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b. For sterility, turn on Bunsen burner and place near hot plate. Sterilize bench area with 

70% ethanol. 

c. Begin boiling water in small beaker on hot plate at your bench. 

d. Melt wax pellets by placing pellets into a smaller beaker. 

e. Place this beaker into the water on hot plate as it begins to boil. 

f. Bring coverslips to bench. Using 200 uL pipet, carefully add wax dots to the corners 

of each coverslip. 

3. Allow to dry in bio-safety cabinet while preparing for dissection. 

4. Add 2 mL NPM per well and place in CO2 incubator at 37C. 

 

5. Genotype mice. 

a. Use a sharpie to number each pup on the belly. 

b. Snip a small piece of the tail and transfer to individually numbered tubes. 
c. Digest tail snips to extract DNA and perform genotyping by following the Diaz Lab 

genotyping protocol. 

d. Separate wildtype animals from knockout animals and proceed to dissection. 

 

6. Perform Hippocampal Dissection and plating. 

a. Before dissection, sterilize tools at 250C for 15 minutes (dry bath in dissection room). 

b. Euthanize E18-E19 pregnant rat with carbon dioxide. Ensure complete euthanasia by 

cervical dislocation. 

c. Spray abdomen with 70% ethanol. 

d. Cut through skin and remove the uterus to a petri dish. 

e. Remove fetuses from the uterus, decapitate, and put heads in dissection buffer on ice. 
f. Remove the hippocampi from each brain being careful to remove all meninges, and 

transfer to a 15 mL conical tube on ice. 
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g. Transfer wildtype and SynDIG4-knockout tissue to separate 15 mL tubes. 

h. Add 100 µL papain (Wellingsworth) to each tube with 5 mL dissection media. Warm 

in 37°C water bath to aid in dissolving. Filter sterilize before use. 

i. Incubate hippocampi in 37C water bath for 15 min, inverting gently every few minutes. 

j. After incubation, add 5 mL of NPM. 

k. Centrifuge for 5 min at 1000 rpm and carefully remove the supernatant. 
l. Resuspend pellet in 3 mL of NPM and dissociate cells by pipetting up and down with 

a 1 mL pipette 5x, followed by trituration 10x with a fire polished long stem pipette 

until most chunks of tissue have been dissociated. 

m. Add NPM to a final volume of 5mL. 
n. Use a hemacytometer to determine cell density (45 uL of cell suspension plus 5 uL of 

trypan blue). Trypan blue will stain dead cells blue. Do not include dead cells in your 

count. 

o. Dilute cells to 60,000 cells per mL of NPM (make sure to account for pipetting error). 

Add 2 mL of cells to each well containing PLL coated coverslips. This will give a final 

cell density of 120,000 cells per well and a total volume of 2 mL per well. 

p. Place dishes in incubator for 5 – 6 hours. 

q. Transfer coverslips, wax dot side down, to the plates containing astrocyte feeder layers. 

r. Place in C02 incubator. 

s. Perform a half media change every 5 days by removing 2.5 mL old media and adding 

3 mL fresh NBC. 
 

Day 6 (4 DIV): 

1. Add AraC (10 mM stock; 5 uM final concentration) per well directly to culture medium 

(1:2000 dilution from stock in -20oC, i.e. 2.5 uL AraC to 5 mL NBC). 

Day 7 (5 DIV) …Day 12 (10 DIV), etc.: 
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1. Half media change. Remove 2.5 mL of media and replace with 3 mL fresh NBC. Perform 

half media change every 5 days. 
2. Fix and stain neurons at 14 DIV, or appropriate age, depending on development and 

confluency. 

**This protocol can also be used for cortical cultures. However, cortical tissue must be 

mechanically “chopped” with forceps into smaller pieces before digestion. Cortical 

neurons will also mature more quickly than hippocampal neurons. ** 

 

Media Formulations: 

Dissection Buffer: 

• 500 mL HBSS (remove 10 mL) 

• 5 mL HEPES 

• 5 mL Sodium pyruvate 

 

Astrocyte Plating Media (APM): 

• 500 mL 1X MEM (remove 65 mL) 

• 10% Donor horse serum (50 mL) 

• 0.6% Glucose (10 mL of 30% glucose stock in Milli-Q water) 

• 5 mL Penicillin/Streptomycin 

 

Neuronal Plating Media (NPM): 

• 500 mL 1X MEM (remove 68 mL) 

• 10% Donor horse serum (50 mL) 

• 0.45% glucose (7.5 mL of 30% glucose stock in Milli-Q water) 

• 5 mL Sodium pyruvate 

• 5 mL Penicillin/Streptomycin 
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Neurobasal complete (NBC): 

• 500 mL Neurobasal (remove 27 mL) 

• 5 mL Hepes 

• 5 mL Sodium Pyruvate 

• 5 mL Penicillin/ Streptomycin 

• 1.5 mL L-glutamine 

 

****Filter sterilize**** 

 

• Add 10 mL B-27 after filter sterilizing 

 

 

 

 

 

Additional Solutions: 

 

Poly-L-Lysine Solution (PLL): 

 

PLL stocks are at 200 mg/uL located in the -20C fridge. 
 

For 25 ug/uL: 

• Dilute stock at 1:8,000 in 0.1 M Borate Buffer, i.e. add 6.25 uL PLL to 50 mL 0.1M Borate 

Buffer 

 

For 1 mg/uL: 

• Dilute stock at 1:200 in 0.1 M Borate Buffer, i.e. add 50 uL PLL to 10 mL 0.1 M Borate 

Buffer 
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0.1 M Borate Buffer 

• 900 mL milli-Q water 

• 17.2 g sodium tetra-borate 

• 3.1 g boric acid 

• Adjust pH to 8.5 

• Bring up to 1 L with milli-Q water 

• Filter Sterilize 

 

1M Nitric Acid: 

• Add 64 mL 70% w/w 15.8 N nitric acid to 250 mL H20.  

• Bring up to 1000 mL. 
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Banker Style Primary Rat Hippocampal Culture 

 

Outline: 

 

Day 1 (Monday): Coat plates with poly-L-lysine (PLL) for astrocytes. Order E16 timed pregnant 

rat through TRACS/ATS (Animal Tracking System) 

1. Strain: SD 

2. Gestation requirements: E16 

3. Vendors: ENVIGO or Charles River 

4. Vivarium: TRACS/GBSF 636 

Day 2 (Tuesday): Plate astrocytes. 
 

Day 5 (Friday): Change astrocyte plating media (APM). 
 

Day 8 (Monday): Change APM. Perform nitric acid sterilization and etching of coverslips. 
 

Day 9 (Tuesday): Place wax dots on coverslips for primary neurons. 
 

Day 10 (Wednesday): Replace APM media on astrocytes with NMM. Coat coverslips with PLL 

for neurons. 
 

Day 11 (Thursday): Perform hippocampal dissection and plating. 
 

Day 15 (Monday): Add AraC to each well of neurons for a final concentration of 5 µM. 
 

Day 16 (Tuesday – 5 DIV) … Day 21 (Sunday – 10 DIV), etc.: Half media change. Fix and stain 

neurons at ~14 DIV, or alternative appropriate date. 
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Sequence of events and detailed procedures: 

 

Day 1 (Monday): 

1. Coat 6-well plates with 25 µg/µL of poly-L-lysine (PLL) in 0.1 M Borate buffer. Incubate 

overnight in C02 incubator at 37oC. 

2. Order an E16 timed pregnant rat to arrive the following week (next Tuesday). 
a. Strain: SD 

b. Gestation requirements: E16 

c. Vendors: ENVIGO or Charles River 

d. Vivarium: TRACS/GBSF 636 

 

Day 2 (Tuesday): 

1. Wash 6-well plates 3x with Milli-Q water. Keep in last wash until astrocytes are ready to 

be plated. 

2. Revive frozen astrocytes by thawing quickly in water bath. 1 mL of frozen astrocytes (1 

vial) will be enough for two 6-well plates. 
3. Transfer thawed astrocytes into Astrocyte Plating Media (APM), and plate 2 mL of 

suspended astrocytes per well. 

4. Place in C02 incubator. Monitor cells after 2 days, confluency should be around 20%. 

 

Day 5 (Friday): 

1. Change APM media for astrocytes. 

 

Day 8 (Monday): 

1. Change APM media for astrocytes. 
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2. Perform nitric acid sterilization and etching of glass coverslips 

a.   Place coverslips in ceramic racks and place racks in glass container.  

b.   Wash coverslips 1x with Milli-Q water to remove any dust/particles. 

c.   Fill container with 1M Nitric Acid (coverslips should be completely submerged). 

d.   Place glass container on shaker at RT at low speed overnight. 

e.   Remove Nitric Acid and save for future use (can be used up to three times). 

f.    Rinse glass container and coverslips 3x with Milli-Q water (quick rinses). Container 

with Milli-Q water so coverslips are submerged and place on shaker at low speed 

3x for 20 minutes each. Ethanol rinse to aid drying. 

g.   Remove excess liquid by tapping ceramic racks on Kim-wipes. 

h.   Wrap in foil and autoclave on Cycle 8 (wrapped at 250 oC). 
 

Day 9 (Tuesday): 

1. Place wax dots on coverslips.  

a. Transfer coverslips to 6-well plates (at least four; 24 coverslips total) in  biosafety 

cabinet. 

b. For sterility, turn on Bunsen burner and place near hot plate. Sterilize bench area 

with 70% ethanol. 

c. Begin boiling water in small beaker on hot plate at your bench. 

d. Melt wax pellets by placing pellets into a smaller beaker. 

e. Place this beaker into the water on hot plate as it begins to boil. 

f. Bring coverslips to bench. Using 200 uL pipet, carefully add wax dots to the corners 

of each coverslip. 
 

2. Allow to dry in bio-safety cabinet overnight. 
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Day 10 (Wednesday): 

1. Replace APM media with 5 mL Neuronal Maintenance Media (NMM). 

2. Coat etched/sterilized coverslips (with wax dots) with 1 mg/mL of PLL in 0.1M Borate 

buffer. Use 350 µL solution per well and bubble on top of coverslips using a 1 mL pipet. 

Incubate in the C02 incubator overnight. 

 

Day 11 (Thursday): 

1. Wash coverslips 3x with Milli-Q water. 

2. Add 2 mL NPM per well and place in CO2 incubator at 37C. 

3. Perform Hippocampal Dissection and plating. 

a. Before dissection, sterilize tools at 250C for 15 minutes (dry bath in dissection room). 

b. Euthanize E18-E19 pregnant rat with carbon dioxide. Ensure complete euthanasia by 

cervical dislocation. 

c. Spray abdomen with 70% ethanol. 

d. Cut through skin and remove the uterus to a petri dish. 

e. Remove fetuses from the uterus, decapitate, and put heads in dissection buffer on ice. 
f. Remove the hippocampi from each brain being careful to remove all meninges, and 

transfer to a 15 mL conical tube on ice. 

g. Add 4.5 mL of dissection buffer and 0.5 mL of 2.5% Trypsin (Gibco). 

h. Incubate hippocampi in 37C water bath for 12 min, inverting gently every few minutes. 

i. After incubation, add 5 mL of NPM. 

j. Centrifuge for 5 min at 1000 rpm and carefully remove the supernatant. 
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k. Resuspend pellet in 3 mL of NPM and dissociate cells by pipetting up and down with 

a 1 mL pipette 3x, followed by trituration x10 with a fire polished long stem pipette 

until most chunks of tissue have been dissociated. 

l. Add NPM to a final volume of 5mL. 
m. Use a hemacytometer to determine cell density (45 uL of cell suspension plus 5 uL of 

trypan blue). Trypan blue will stain dead cells blue. Do not include dead cells in your 

count. 

n. Dilute cells to 50,000 cells per mL of NPM (make sure to account for pipetting error). 

Add 1 mL of cells to each well containing PLL coated coverslips. This will give a final 

cell density of 50,000 cells per well and a total volume of 3 mL per well. 

o. Place dishes in incubator for 4 – 6 hours. 

p. Transfer coverslips, wax dot side down, to the plates containing astrocyte feeder layers. 

q. Place in C02 incubator. 

r. Perform a half media change every 5 days by removing 2.5 mL old media and adding 

3 mL fresh NMM. 

 

Day 15 (Monday) – 4 DIV: 

1. Add AraC per well directly to culture medium. Final concentration: 5 uM (1:2000 dilution 

from stock in -20oC, i.e. 2.5 uL AraC to 5 mL NMM). 

 

Day 16 (Tuesday – 5 DIV) … Day 21 (Sunday – 10 DIV), etc.: 

1. Half media change. Remove 2.5 mL of media and replace with 3 mL fresh NMM. Perform 

half media change every 5 days. 
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2. Fix and stain neurons at 14 DIV, or appropriate age, depending on development and 

confluency. 

 

 

** This protocol can also be used for cortical cultures. However, cortical tissue must be 

mechanically “chopped” with forceps into smaller pieces before digestion. Cortical 

neurons will also mature more quickly than hippocampal neurons. ** 
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Media Formulations: 

Dissection Media: 

• 500 mL HBSS 

• 5 mL HEPES 

• 5 mL Sodium pyruvate 

 

Astrocyte Plating Media (APM) 

• 500 mL 1X MEM (remove 65 mL) 

• 10% Donor horse serum (50 mL) 

• 0.6% Glucose (10 mL of 30% glucose stock in Milli-Q water) 

• 5 mL Penicillin/Streptomycin 

 

Neuronal Plating Media (NPM) 

• 500 mL 1X MEM (remove 68 mL) 

• 10% Donor horse serum (50 mL) 

• 0.45% glucose (7.5 mL of 30% glucose stock in Milli-Q water) 

• 5 mL Sodium pyruvate 

• 5 mL Penicillin/Streptomycin 

 

Neuronal Maintenance Media (NMM) 

• 500 mL Neurobasal (remove 25 mL) 

• 10 mL B-27 

• 5 mL Glutamax 

• 5 mL Sodium Pyruvate 

• 5 mL Penicillin/Streptomycin 
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Additional Solutions: 

Poly-L-Lysine Solution (PLL) 

PLL stocks are at 200 mg/uL located in the -20C fridge. 

For 25 ug/uL: 

• Dilute stock at 1:8,000 in 0.1 M Borate Buffer, i.e. add 6.25 uL PLL to 50 mL 

0.1M Borate Buffer 

For 1 mg/uL: 

• Dilute stock at 1:200 in 0.1 M Borate Buffer, i.e. add 50 uL PLL to 10 mL 0.1 M 

Borate Buffer 

 

0.1 M Borate Buffer 

• 900 mL milli-Q water 

• 17.2 g sodium tetra-borate 

• 3.1 g boric acid 

• Adjust pH to 8.5 

• Bring up to 1 L with milli-Q water 

• Filter Sterilize 

 

1M Nitric Acid: 

• Add 64 mL 70% w/w 15.8 N nitric acid to 250 mL H20.  

• Bring up to 1000 mL. 
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ACSF recipe 

 

Fresh ACSF should be made every two weeks. Discard any old ACSF in the fridge. 

 

1. For 1 liter of ACSF, to MilliQ water (950ml) add the following: 

• 7.422g Sodium Chloride (M.W. 58.44) 

• 2.100g Sodium Bicarbonate (M.W. 84.01) 

• 0.173g Monobasic Sodium Phosphate (M.W. 137.99) 

• 0.187g Potassium Chloride (M.W. 74.56) 

• 4.505g Glucose (M.W. 180.20) 

 

2. Increase the volume to 1L with MilliQ water. 

3. Bubble with carbogen until saturated (approx. 15 mins). 

4. Check pH. Should be between 7.10 and 7.20. 

5. Check osmolarity. Should be between 310 and 315. 

6. Rinse bubbler with diH20. 
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When using ACSF, take 200ml of the above solution and add magnesium and calcium: 

 

Magnesium Chloride (M.W. 203.31) 

 100ml 200ml* 500ml 1L 

0.1mmol 0.00102g 0.00408g 0.0102g 0.0204g 

1mmol* 0.0204g 0.0408g* 0.102g 0.204g 

4mmol 0.0816g 0.1632g 0.408g 0.816g 

 

 

Add Calcium Chloride (use the 1M solution on the shelf). 

 100ml 200ml* 500ml 1L 

2mmol* 200µl 400µl* 1ml 2ml 

3mmol 300µl 600µl 1.5ml 3ml 

4mmol 400µl 800µl 2ml 4ml 

 

*Most common concentrations are in bold. 
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Primary Astrocyte Cultures 

 

Astrocyte Plating Media (APM) 

• 500 mL MEM (remove 65 mL) 

• 10% Donor horse serum (50 mL) 

• 0.6% Glucose (10 mL of 30% stock in DI water) 

• 5 mL Penicillin/Streptomycin 

 

 

1. Order time-pregnant rat at E16 (about 1 week before dissection). Rat should give birth around 

E20-E21. 

2. Coat 30 ten cm dishes with 25 ug/mL poly-L-lysine and make new APM. 

3. On day of dissection, wash plates 3x with sterile H20 and leave in hood for plating. 

4. Pick P0 or P1 pups (at least 12). 

5. Sacrifice pups. Decapitate. Place heads in 10 cm dish with dissection buffer 

(HBSS/HEPES/Na-Pyruvate) 

• Dissection buffer: 500 mL HBSS, 5 mL HEPES, 5 mL Na-Pyruvate 

 

6. Remove brains from head and place in new dish with dissection buffer 

7. Under microscope, carefully remove the meninges from brains to expose cortex 

8. Secure brain by placing forceps at 45o angle through upper portion of the cortex. Remove 

small square chunk of tissue with forceps. 

9. Repeat for other brain hemisphere. 

10. Remove any remaining blood vessels and transfer tissue to new dish with dropper. 
11. After tissue has been extracted from all brains, use forceps to break up chunks of isolated 

tissue. 



137 
 

12. Transfer all tissue to 50 mL conical tube and fill to 12 mL with dissection buffer. 

13. Add 1.5 mL of 2.5% Trypsin. 

14. Incubate at 37C for 15 mins. Invert tube every 2 mins. 

15. After incubation, add equal volume of astrocyte plating medium (APM). 

16. Centrifuge at 1000 rpm for 5 mins. 

17. Carefully remove supernatant (do not use suction). 

18. Resuspend pellet in 5 mL APM. 
19. Dissociate cells by pipetting up and down with a Pasteur pipet, and then with a fire polished 

pipet. 

20. Leave suspension so tissue chunks settle to bottom. 

21. Collect supernatant carefully and transfer to clean collection bottle (500 mL). 

22. Bring up to final volume of 300 mL APM. 

23. Add 10 mL to each PLL coated dish. 

24. Change media every 3 days. 

25. Freeze cultures at ~80% confluency (7 – 14 days). 
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Chemical LTP Induction of Primary Hippocampal Neurons 

 

1. Use cultured primary neurons at DIV 12 – 14 depending on confluency and maturity. 
 

2. Equilibrate neurons in artificial cerebrospinal fluid (aCSF) with magnesium (Mg+2) at 37oC 

in incubator for 30 minutes. 
 

3. Wash Cells 1x with PBS. 
 

4. Replace aCSF buffer with either treatment or DMSO mock ctrl. Important: Treatment 

and Ctrl buffer must be Mg+2 free. 
 

a. aCSF Treatment Buffer 

b. 200 µM Glycine; Stock = 1 M 

c. 20 µM Bicuculine; Stock = 20 mM 

d. 3 µM Strychnine; Stock = 1 mM 

e. 2 mM Calcium 

 

5. Incubate at 37oC for 5 minutes. 
 

6. Transfer coverslips to recovery buffer (aCSF w/ Mg+2; No Drugs) for 20 mins at 37oC. 
 

7. Fix with 4% PFA for 5 minutes at room temperature. 
 

8. Wash 3x with PBS. Shaking, 5 minutes each. 
 

9. Store at 4oC in PBS. 
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Surface labeling of Primary Hippocampal Neurons 

 

1. Wash cells 1X with PBS briefly 

 

2. Brief fixation: 4% PFA/4% Sucrose/PBS for 5 min at RT 

 

3. Wash 3X with PBS for 10 mins each 

 

4. Blocking: 10% BSA in PBS for 30 min 

 

5. Incubate with GluA1 antibody at RT for 1 hour 

a. (Neuromab IgG1 anti-GluA1; 1:50) 

 

6. Wash 3X with PBS for 10 mins each 

 

7. Permeabilization:  0.1% Triton X-100 in PBS for 15 mins at RT 

 

 

   ** After permeabilization, you can proceed to normal immunostaining for internal proteins ** 
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The above protocol uses a brief fixation prior to surface labeling. This could potentially 

result in slight permeabilization of the membrane, resulting in antibody leaking into the cell. 

However, this should be minimal, and this protocol is used widely in the literature. 

A second surface staining protocol may be used where the cells are slowly cooled to 4oC. 

This would be a truer surface labeling; however, it is commonly observed that this results in 

increased cell death and abnormal morphology. The protocol is as follows: 

 

1. Place coverslips at RT until the media temperature reaches RT 

2. Transfer coverslips to 4C cold room or ice 

3. Incubate with GluA1 antibody at 4C for 20 mins, shaking 

4. Wash 3X with PBS, briefly 

5. Fix with 4% PFA/4% Sucrose/PBS for 10 mins at RT 

6. Wash 3X with PBS for 10 mins each 

7. Proceed to immunostaining for internal proteins 
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ImageJ Analysis of Dendritic Stretches 

 

1. File > Open > Select Image for Analysis 

2. Image > Color > Make Composite 

3. Image > Color > Split Channels 

4. Determine threshold for 25% of all images. This must be done separately for each channel. 

Save threshold values in an excel file. 

a. Select channel for thresholding 

b. Image > Duplicate 

c. Place both channels next to each other 

d. Select channel for thresholding 

e. Image > Adjust > Threshold 

f. Threshold window should say ‘Default’ and B&W. Select ‘Dark Background.’ 

g. Use the color image to adjust the top threshold value so that the black and white image 

is representative of the color image. Bottom threshold value will remain unchanged. 

5. Close all images. 

6. Once the threshold has been determined for 25% of images, take the average threshold of each 

channel. 

7. Open the three-channel script in notepad or other text editor.  

8. Input threshold values and save the script. Each channel has a space to input the threshold 

values. 
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9. Select 2-3 dendritic stretches from each image. 
 

a. File > Open > Select Image for Analysis 

b. Image > Color > Make Composite 

c. Click on ‘Polygon Selections’ tool. 

d. Select dendrite with polygon tool. 
e. Edit > Clear Outside 

f. File > Save As > TIFF file (to new folder) 

g. Repeat for all Images and Dendritic Stretches 

 

10. Once all dendrites for all images have been selected, close all images. 

11. File > Open > Select Dendrite Image for Analysis 

12. Select either ‘Segmented Line’ or ‘Freehand Line’ tool. 

13. Trace the length of the dendrite. 

14. Analyze > Measure 

15. Record the dendritic length in excel. This will be necessary to determine puncta density. 

Additionally, make sure unit of length is set to micron. (Analyze > Set Scale) 

16. Close results. 

17. Plugins > Macros > Run > Select script with thresholds from earlier. 

18. Record the summary results in excel for each dendrite. 
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ImageJ Protocol for Manual Analysis of Puncta Clusters 

in Heterologous Cells 

 

1. File > Open > Select Image for Analysis 

2. Image > Color > Make Composite 

3. Image > Color > Split Channels 

4. Determine threshold for 25% of all images. This must be done separately for each channel. 

Save threshold values in an excel file. 

 

a. Select channel for thresholding 

b. Image > Duplicate 

c. Place both channels next to each other 

d. Select channel for thresholding 

e. Image > Threshold 

f. Threshold window should say ‘Default’ and B&W. Select ‘Dark Background.’ 

g. Use the color image to adjust the top threshold value so that the black and white image 

is representative of the color image. Bottom threshold value will remain unchanged. 

 

5. Close all images. 

6. Once the threshold has been determined for 25% of images, take the average threshold of each 

channel. 

7. Open the two-channel script in notepad or other text editor.  
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8. Input threshold values and save the script. Each channel has a space to input the threshold 

values for SD4 and the receptor. 

9. File > Open > Select Image for Analysis 

10. Identify a representative secondary or tertiary dendritic stretch. 

11. Using the freehand selection tool, select the dendrite of interest. 

12. Edit > Clear Outside 

13. Save image as a TIF file to a new folder. 

14. Right click on the line tool and select freehand line. 

15. Trace the representative dendritic stretch linearly down the middle of the dendrite. 

16. Analyze > Measure. Record the length of the dendritic stretch. 

17. Plugins > Macros > Open. Select script for analysis and save all results. 

18. Divide the number of puncta by the length to obtain puncta density. 
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